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ΠΔΡΗΛΖΦΖ 
 

΢ηελ παξνύζα πηπρηαθή εξγαζία ππνινγίδεηαη ν ζπληειεζηήο έληαζεο 

ηάζεο ζε ξεγκαησκέλν γξαλάδη. Γηα λα ππάξρεη κέηξν ζύγθξηζεο ησλ 
απνηειεζκάησλ καο πξαγκαηνπνηήζακε κειέηε ηάζεσλ θαη παξακνξθώζεσλ ζε 

γξαλάδη ρσξίο ξσγκή θαη ζε γξαλάδη κε ξσγκή. Δπηπιένλ ε κειέηε ζην γξαλάδη 
ρσξίο ξσγκή πξαγκαηνπνηήζεθε γηα λα βξνύκε ηελ πεξηνρή ησλ κέγηζησλ 

ηάζεσλ θαη ζε απηή ηελ πεξηνρή λα ζρεδηάζνπκε ηελ ξσγκή. Ο ππνινγηζκόο 
ηνπ ζπληειεζηή έληαζεο ηάζεο πξαγκαηνπνηήζεθε κε ηε κέζνδν ησλ 

πεπεξαζκέλσλ ζηνηρείσλ κε ηε ρξήζε ηνπ εκπνξηθνύ πξνγξάκκαηνο 
ειεθηξνληθώλ ππνινγηζηώλ ANSYS. Δκείο  ζπγθεθξηκέλα ρξεζηκνπνηήζακε 

ηελ έθδνζε ηνπ πξνγξάκκαηνο ANSYS 9.0. 

H παξνύζα πηπρηαθή εξγαζία απαξηίδεηαη από ηξία θεθάιαηα, ηα νπνία 

αλαθέξνληαη ζηα εμήο: 

 ΢ην πξώην θεθάιαην γίλεηαη αλαιπηηθή πεξηγξαθή ησλ ραξαθηεξηζηηθώλ 
ησλ νδνλησηώλ ηξνρώλ, αλάιπζε ηεο ζεσξίαο επαθώλ ηνπ Hertz, πεξηγξαθή 

ηνπ βαζηθνύ λόκνπ ηεο νδόλησζεο θαη πεξηγξαθή ηνπ ηξόπνπ ππνινγηζκνύ ηνπ 
νδόληα ζε πίεζε επηθάλεηαο. Δπίζεο πεξηγξάθεηαη ε κεραληθήο ηεο ζξαύζεο θαη 

πην εηδηθά ε ζξαύζε, ε αλάιπζε ηάζεσλ ζηηο ξσγκέο, ν ζπληειεζηήο έληαζεο 
ηάζεο θαη ε αληίζηαζε ζξαύζεο (ή θξίζηκνο ζπληειεζηήο έληαζεο ηάζεο), 
γίλεηαη θαη κία αλαθνξά ζηε κέζνδν πεπεξαζκέλσλ ζηνηρείσλ θαη ηέινο κηα 

ζύληνκε πεξηγξαθή ηνπ πξνγξάκκαηνο πεπεξαζκέλσλ ζηνηρείσλ ANSYS, 
δειαδή ηη δπλαηόηεηεο έρεη θαη πνπ βξίζθεη εθαξκνγέο ζηε ζύγρξνλε 

Μεραληθή.  

 ΢ην δεύηεξν θεθάιαην πεξηγξάθεηαη αλαιπηηθά ε ζρεδίαζε θαη επίιπζε 
ηεζζάξσλ ραξαθηεξηζηηθώλ παξαδεηγκάησλ κε ηε ρξήζε ηνπ πξνγξάκκαηνο 

ANSYS, σο αληηπξνζσπεπηηθό δείγκα ησλ πξνβιεκάησλ πνπ επηιύζεθαλ ζην 
πιαίζην εθκάζεζεο ηνπ πξνγξάκκαηνο. Απηά είλαη αλάιπζε ζε επίπεδε πιάθα 

κε νπή ζην θέληξν ηεο, αλάιπζε ηνπ κεηαιιηθνύ ηκήκαηνο δώλεο απηνθηλήηνπ, 
αλάιπζε πιάθαο κε ξσγκή ζηελ κέζε θαη ηέινο αλάιπζε πιάθαο κε ξσγκή 
ζηελ άθξε ηεο κίαο ηεο πιεπξάο. 

 Σέινο, ζην ηξίην θεθάιαην, πνπ είλαη θαη ην βαζηθό ζέκα ηεο πηπρηαθήο 

καο εξγαζίαο, πξαγκαηνπνηείηαη ν αξηζκεηηθόο ππνινγηζκόο ηνπ ζπληειεζηή 
έληαζεο ηάζεο ηνπ ξεγκαησκέλνπ γξαλαδηνύ.  

 

 ΢ην παξάξηεκα ζην ηέινο απηήο ηεο εξγαζίαο θαίλεηαη ν ηξόπνο 
θαηαζθεπήο ησλ παξαδεηγκάησλ ηνπ ηξίηνπ θεθαιαίνπ κε ην ANSYS, 

αλαιπηηθά βήκα πξνο βήκα. 
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ΚΔΦΑΛΑΗΟ 1 

 

1.1  ΘΡΑΤ΢Ζ 

       

Απιή ζξαύζε είλαη ν δηαρσξηζκόο ελόο ζώκαηνο ζε δύν ή πεξηζζόηεξα 
ηκήκαηα, σο απνηέιεζκα ελόο επηβαιιόκελνπ θνξηίνπ (δειαδή ζηαζεξήο ή 

πνιύ αξγά κεηαβαιιόκελεο κε ην ρξόλν), ζε ζεξκνθξαζίεο ρακειέο ζε ζρέζε 
κε ηελ ζεξκνθξαζία ηήμεο ηνπ πιηθνύ. Σν εθαξκνδόκελν θνξηίν κπνξεί λα 

είλαη εθειθπζηηθό, ζιηπηηθό, δηαηκεηηθό, ή ζηξεπηηθό. Κάζε δηαδηθαζία ζξαύζεο 
εκπεξηέρεη δύν δηαθξηηά ζηάδηα: ην ζρεκαηηζκό ηεο ξσγκήο θαη ηελ δηάδνζε ηεο 

ξσγκήο σο απνηέιεζκα επηβνιήο ηάζεο. Ζ ζξαύζε ησλ πιηθώλ γεληθά 
δηαθξίλεηαη ζε δύν κεγάιεο θαηεγνξίεο: όιθηκε θαη ςαζπξή. Ο ηύπνο ηεο 

ζξαύζεο εμαξηάηαη θαηά πνιύ από ηνλ κεραληζκό δηάδνζεο ηεο ξσγκήο. Ζ 
όιθηκε ζξαύζε ραξαθηεξίδεηαη από ην κεγάιν πνζνζηό πιαζηηθήο 

παξακόξθσζεο πνπ πθίζηαηαη ην πιηθό, πξηλ θαη θαηά ηε δηάξθεηα δηάδνζεο 
ησλ ξεγκώλ, νη νπνίεο ηειηθά επηθέξνπλ ηε ζξαύζε (΢ρήκα 1.1α). Αληίζεηα, ε 

ςαζπξή ζξαύζε ραξαθηεξίδεηαη από ηελ κεγάιε ηαρύηεηα κε ηελ νπνία 
πξνσζνύληαη ηα ξήγκαηα ζην πιηθό, ρσξίο λα πξνθαιέζνπλ πιαζηηθή 

παξακόξθσζε (΢ρήκα 1.1γ). Ζ πηζαλόηεηα εκθάληζεο ςαζπξήο ζξαύζεο 
απμάλεηαη κε κείσζε ηεο ζεξκνθξαζίαο, κε αύμεζε ηεο ηαρύηεηαο θόξηηζεο θαη 
κε ηελ παξνπζία εγθνπώλ ή άιισλ αζπλερεηώλ ζην πιηθό. Ζ ςαζπξή ζξαύζε, 

αθξηβώο επεηδή ζπκβαίλεη αθαξηαία θαη ρσξίο πξνεηδνπνίεζε, είλαη ζπλήζσο 
ηδηαίηεξα θαηαζηξνθηθή θαη ν ζρεδηαζκόο θαηαζθεπώλ πξέπεη λα γίλεηαη κε 

βαζηθό θξηηήξην ηελ απνθπγή ηεο. 

Όηαλ έλα όιθηκν κεηαιιηθό ζώκα ππνβάιιεηαη ζε δνθηκή εθειθπζκνύ, 
κεηά από θάπνηα ηηκή ηάζεο ην ζώκα ιεπηαίλεη, παξνπζηάδεη ιαηκό, 

εκθαλίδνληαη ζ' απηό κηθξνθελά θαη ξεγκαηώζεηο, θαη ηέινο επέξρεηαη ζξαύζε. 
΢ύκθσλα κε ην πρότυπο Griffith, ζηα ςαζπξά κέηαιια, ε ζξαύζε επέξρεηαη ηελ 
εκθάληζε θαη ηε κεηαηόπηζε ξσγκήο. 

Ζ ζξαύζε ραξαθηεξίδεηαη αλάινγα κε ηελ θξπζηαιιηθή αζηνρία 
(δηάηκεζε), αλάινγα κε ηελ επηθάλεηα ζξαύζεο (ηλώδεο ή θνθθώδεο) θαη 

αλάινγα κε ηελ ηάζε ζξαύζεο (όιθηκε ή ςαζπξή). ΢ηελ πξάμε, ε ζξαύζε ησλ 
κεηάιισλ παξαηεξείηαη κε δνθηκέο αληνρήο ή εθειθπζκνύ θαη ε αληνρή ησλ 

κεηάιισλ κπνξεί λα εθηηκεζεί κε δνθηκέο ζθιεξόηεηαο. 

Ζ ζεξκνθξαζία έρεη ζεκαληηθή επίδξαζε ζηε ζξαύζε ησλ κεηάιισλ. Όια 

ηα κέηαιια είλαη όιθηκα, αιιά γίλνληαη ςαζπξά θάησ από κηα ζπγθεθξηκέλε 
ζεξκνθξαζία, ε νπνία είλαη ραξαθηεξηζηηθή γηα θάζε κέηαιιν.  

 

 



 

 

2 

 

΢ρήµα 1.1: (α) Ηζρπξά όιθηµε ζξαύζε θαηά ηελ νπνία ην δνθίµην παξνπζηάδεη 

ζηέλσζε ("ιαηµό") πνπ θζάλεη σο ηελ δεµηνπξγία ζεµείνπ ζξαύζεο. (β) Μέηξηα όιθηµε 
ζξαύζε µεηά ην ζρεµαηηζµό µηθξνύ βαζµνύ ζηέλσζεο. (γ) Φαζπξή ζξαύζε ρσξίο θαµµία 

πιαζηηθή παξαµόξθσζε. (Σν ζρήκα έρεη παξζεί από William D. Callister Jr., Δπηζηήκε θαη 

ηερλνινγία ησλ πιηθώλ, 5ε έθδνζε, Δθδόζεηο Σδηόια, Θεζζαινλίθε 2004).  

 

1.2 ΢ΤΓΚΔΝΣΡΧ΢Ζ ΣΑ΢ΔΧΝ  

 

Ζ αληνρή ζε ζξαύζε ελόο ζηεξενύ πιηθνύ είλαη ζπλάξηεζε ησλ 

ζπλεθηηθώλ δπλάκεσλ πνπ πθίζηαληαη κεηαμύ ησλ αηόκσλ. ΢ε απηήλ ηελ βάζε, 
ε ζεσξεηηθή αληνρή ελόο ςαζπξνύ ειαζηηθνύ ζηεξενύ έρεη ππνινγηζζεί όηη 

είλαη πεξίπνπ ίζε κε Δ/10, νπνύ Δ είλαη ην κέηξν ειαζηηθόηεηαο ηνπ πιηθνύ. Οη  
πεηξακαηηθέο (πξαγκαηηθέο) όκσο ηηκέο ηεο αληνρήο ζε ζξαύζε ησλ 
πεξηζζνηέξσλ πιηθώλ ηνπ κεραληθνύ είλαη ζπλήζσο 1000 θνξέο θάησ από ηελ 

ζεσξεηηθή ηηκή (Δ/1000). Ο Griffith πξνηείλε πσο ε αζπκθσλία κεηαμύ ηεο 
ζεσξεηηθήο αληνρήο θαη ηεο πξαγκαηηθήο αληνρήο ζε ζξαύζε κπνξεί λα 

εμεγεζεί από ηελ παξνπζία κηθξνζθνπηθώλ αηειεηώλ ή ξσγκώλ, πνπ πάληνηε 
πθίζηαληαη ζε θαλνληθέο ζπλζήθεο ζηελ επηθάλεηα θαη ζην εζσηεξηθό ησλ 

πιηθώλ. Οη αηέιεηεο απηέο είλαη επηδήκηεο γηα ηελ αληνρή ζε ζξαύζε θαζώο κηα 
εθαξκνδόκελε ηάζε κπνξεί λα εληζρπζεί ή λα ζπγθεληξσζεί ζην άθξν ηεο 

αηέιεηαο. Σν κέγεζνο ηεο ελίζρπζεο εμαξηάηαη από ηνλ πξνζαλαηνιηζκό θαη ηελ 
γεσκεηξία ηεο ξσγκήο ζε ζρέζε κε ηελ θόξηηζε. 

Αλ ππνζέζνπκε όηη κία ξσγκή έρεη ειιεηπηηθό ζρήκα (ή είλαη θπθιηθή) 
θαη όηη πξνζαλαηνιίδεηαη θάζεηα ζηελ εθαξκνδόκελε ηάζε, ε κέγηζηε ηάζε ζην 

άθξν ηεο ξσγκήο, ζm είλαη ίζε κε  

 

1/2

1m

t




 



  
    
   

    (1.1) 



 

 

3 

όπνπ ζν είλαη ην κέγεζνο ηεο νλνκαζηηθήο εθειθπζηηθήο ηάζεο, ξ t είλαη ε αθηίλα 

θακππιόηεηαο ηεο αηρκήο ηεο ξσγκήο, θαη α πνζόηεηα πνπ αλαπαξηζηά ην 
κήθνο επηθαλεηαθήο ξσγκήο, ή ην ήκηζπ ηνπ κήθνπο κηαο εζσηεξηθήο ξσγκήο. 
Δπίζεο πξέπεη λα αλαθέξνπκε όηη όζν πην θνληά βξηζθόκαζηε ζηελ άθξε ηεο 

ξσγκήο, ηόζν κεγαιύηεξε είλαη ε ζπγθέληξσζε ηάζεσλ.   

 

1.2.1 Αλάιπζε ηάζεωλ ζηηο ξωγκέο  

 

 Μία ξσγκή κπνξεί λα δηαδνζεί κε δηάθνξνπο ηξόπνπο κέζα ζε έλα πιηθό, 
ζε ζρέζε κε ηηο ηάζεηο πνπ πξνζπαζνύλ λα «αλνίμνπλ» ηηο πιεπξηθέο ηνπ 

επηθάλεηεο (δειαδή ηηο επηθάλεηεο ζξαύζεο). Οη ηξόπνη απηνί ρσξίδνληαη ζε 
ηξεηο βαζηθέο θαηεγνξίεο, πνπ νλνκάδνληαη ηύπνο I, ηύπνο II θαη ηύπνο III θαη 
θαίλνληαη παξαζηαηηθά ζην ΢ρήκα 1.2. Γηα θάζε έλαλ από ηνπο ηξεηο απηνύο 

ηξόπνπο νξίδεηαη θαη ν αληίζηνηρνο παξάγνληαο έληαζεο ηάζεσλ, δειαδή K
I
, K

II 

θαη K
III

. ΢ηνλ ηύπν I νη πιεπξηθέο επηθάλεηεο ηεο ξσγκήο απνκαθξύλνληαη ε κία 

από ηελ άιιε θάησ από ηελ επίδξαζε εθειθπζηηθήο νξζήο ηάζεο θάζεηεο ζηηο 
επηθάλεηεο απηέο. ΢ηνλ ηύπν II ε δηάδνζε ηεο ξσγκήο γίλεηαη κε ηελ επίδξαζε 

δηαηκεηηθήο ηάζεο παξάιιειεο ζηηο πιεπξηθέο ηνπ επηθάλεηεο, ελώ ζηνλ ηύπν 
III έρνπκε θαη πάιη δηαηκεηηθή ηάζε παξάιιειε ζηηο πιεπξηθέο επηθάλεηεο αιιά 

κε θνξά θάζεηε ζε ζρέζε κε ηνλ ηύπν II. 

 

  

΢ρήκα 1.2: Οη ηξεηο ηύπνη κεηαηόπηζεο ησλ επηθαλεηώλ ξσγκήο. (α) Σύπνο Η, αλνηθηόο (ή 
ηύπνο δηάλνημεο) ή εθειθπζηηθόο ηύπνο, (β) ηύπνο ΗΗ, ηύπνο νιίζζεζεο θαη (γ) ηύπνο ΗΗΗ, απν-
ζρηζηηθόο ηύπνο. (Σν ζρήκα έρεη παξζεί από William D. Callister Jr., Δπηζηήκε θαη 

ηερλνινγία ησλ πιηθώλ, 5ε έθδνζε, Δθδόζεηο Σδηόια, Θεζζαινλίθε 2004). 

 

 

 Οη ηάζεηο νη νπνίεο δξνπλ πάλσ ζε έλα ζηνηρείν πιηθνύ, ζηε δηακόξθσζε 

ηνπ ηύπνπ Η, θαίλνληαη ζην ΢ρήκα 1.3. Υξεζηκνπνηώληαο ηηο αξρέο ηεο ζεσξίαο 
ειαζηηθόηεηαο θαη ην ζπκβνιηζκό πνπ ζεκεηώλεηαη, νη εθειθπζηηθέο (ζx θαη ζy)  
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θαη δηαηκεηηθέο (ηxy) ηάζεηο είλαη ζπλαξηήζεηο ηόζν ηεο αθηηληθήο απόζηαζεο r 

όζν θαη ηεο γσλίαο θ σο αθνινύζσο: 

 

 
2

x x

K
f

r
 


     (1.2α) 

 

 
2

y y

K
f

r
 


     (1.2β) 

 

 
2

xy xy

K
f

r
 


     (1.2γ) 

 

 

 

Οη ζπλαξηήζεηο f(ζ) έρνπλ σο εμήο: 

 

 

 

3
cos 1 sin sin

2 2 2

3
cos 1 sin sin

2 2 2

3
sin cos cos

2 2 2

x

y

xy

f

f

f

  


  


  


 
  

 

 
  

 


 

 

΢ηελ πεξίπησζε πνπ ν επίπεδνο δίζθνο είλαη ιεπηόο ζε ζρέζε κε ηηο δηαζηάζεηο 

ηεο ξσγκήο, ηόηε ζz = 0, δειαδή ηζρύεη ε ζπλζήθε επίπεδεο ηάζεο. ΢ην άιιν 
άθξν (ζε ζρεηηθά παρύ δίζθν) ηζρύεη ζz = λ (ζx + ζy) θαη ε θαηάζηαζε 

αλαθέξεηαη σο επίπεδε παξακόξθσζε (θαζώο εz = 0), όπνπ λ είλαη ν ιόγνο 
Poisson.  
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΢ρήκα 1.3: Οη ηάζεηο πνπ δξνπλ ζην κέησπν δηάδνζεο ξσγκήο πνπ θνξηίδεηαη εθειθπζηηθά 

ζε δηακόξθσζε ηνπ ηύπνπ Η. (Σν ζρήκα έρεη παξζεί από William D. Callister Jr., Δπηζηήκε 

θαη ηερλνινγία ησλ πιηθώλ, 5ε έθδνζε, Δθδόζεηο Σδηόια, Θεζζαινλίθε 2004). 

  

 

1.3 ΢ΤΝΣΔΛΔ΢ΣΖ΢ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ 

 

 ΢ηηο Δμηζώζεηο 1.2, ε παξάκεηξνο Κ απνθαιείηαη ζπληειεζηήο έληαζεο 

ηάζεο. Ο ζπληειεζηήο έληαζεο ηάζεο Κ ρξεζηκνπνηείηαη ζηελ ζξαπζηνκεραληθή 
γηα λα ππνινγηζηεί ε θαηάζηαζε ηάζεο (έληαζε ηάζεο) θνληά ζηελ άθξε κηαο 
ξσγκήο ε νπνία πξνθιήζεθε από έλα απνκαθξπζκέλν θνξηίν ή παξακέλνπζεο 

ηάζεηο. Δίλαη έλα ζεσξεηηθό κέγεζνο πνπ νξίδεηαη ζε έλα νκνγελέο ειαζηηθό 
πιηθό θαη είλαη ρξήζηκν γηα ηελ παξνρή ελόο θξηηεξίνπ αζηνρίαο γηα εύζξαπζηα 

πιηθά. 

 Ζ ηηκή ηνπ Κ εμαξηάηαη από ηε γεσκεηξία ηεο θαηαζθεπήο, ην κέγεζνο 
θαη ηελ ζέζε ηεο ξσγκήο. (Δμίζσζε 1.3) 

 

K Y a      (1.3) 

 

Σν Τ είλαη κία αδηάζηαηε παξάκεηξνο ή ζπλάξηεζε πνπ νλνκάδεηαη 
παξάγνληαο ζρήκαηνο ή γεσκεηξίαο θαη εμαξηάηαη από ηε κνξθή ηεο ξσγκήο 

(ειιεηπηηθό, εκηειιεηπηηθό, εκηθπθιηθό, θ.ν.θ.), ηε ζέζε ηνπ ζην πιηθό 
(επηθαλεηαθό, εζσηεξηθό), ηε γεσκεηξία θαη ηηο δηαζηάζεηο ηνπ δνκηθνύ 

ζηνηρείνπ ή εμαξηήκαηνο ζην νπνίν βξίζθεηαη ε ξσγκή, θαζώο θαη από ηελ 
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εληαηηθή θαηάζηαζε.  Δπηπιένλ, πξέπεη λα ζεκεησζεί όηη ε κνλάδα κέηξεζεο 

ηνπ Κ είλαη Ν/mm
2

mm
 
(psi in  ελαιιαθηηθά ksi in ). 

 Δάλ δύν ξσγκέο δηαθνξεηηθήο γεσκεηξίαο έρνπλ ηνλ ίδην ζπληειεζηή 
έληαζεο ηάζεσλ, ηόηε ην ηαζηθό πεδίν γύξσ από ηα ξήγκαηα απηά ζα είλαη ην 

ίδην. Σηκέο ηνπ παξάγνληα έληαζεο ηάζεσλ Κ γηα δηάθνξεο γεσκεηξίεο ξσγκώλ 
θαη γηα δηάθνξεο εληαηηθέο θαηαζηάζεηο κπνξνύλ λα ππνινγηζηνύλ κέζσ ηεο 

ζεσξίαο ειαζηηθόηεηαο.  

Γηα πιάθα άπεηξνπ πάρνπο ν ζπληειεζηήο έληαζεο ηάζεσλ δίδεηαη από 
ηελ Δμίζσζε 1.4: 

K a      (1.4) 

 

1.3.1 Αληίζηαζε ζξαύζεο (ή θξίζηκνο ζπληειεζηήο έληαζεο ηάζεο) 

 

 Ζ ζξαύζε επέξρεηαη όηαλ ην κέηξν ηεο εθαξκνδόκελεο ηάζεο ππεξβεί κία 
θξίζηκε ηηκή ζc. Με παξόκνην ηξόπν, θαζώο νη ηάζεηο ζηελ πεξηνρή ηεο αηρκήο 

ηεο ξσγκήο νξίδνληαη κε όξνπο ηνπ ζπληειεζηή έληαζεο ηάζεσλ, ππάξρεη κία 
θξίζηκε ηηκή ηνπ Κ πνπ κπνξεί λα ρξεζηκνπνηεζεί γηα λα πξνδηαγξάςεη ηηο 

ζπλζήθεο ςαζπξήο ζξαύζεο.  

 Απηή ε θξίζηκε ηηκή νλνκάδεηαη αληίζηαζε ζξαύζεο (ή θξίζηκνο 

ζπληειεζηήο έληαζεο ηάζεο) Kc θαη νξίδεηαη από ηελ Δμίζσζε 1.5 σο εμήο: 

 

( / W)c c        (1.5) 

 

Δδώ ζc είλαη θαη πάιη ε θξίζηκε ηάζε γηα ηελ δηάδνζε ηεο ξσγκήο θαη ε ζπ-
λάξηεζε Τ αλαπαξηζηά ηελ εμάξηεζε ηόζν από ην κήθνο ηεο ξσγκήο α, όζν θαη 

από ην πάρνο ηνπ εμαξηήκαηνο W δειαδή, σο Τ(α/W).  

Γηα ηηο ηηκέο ηεο ζπλάξηεζεο Τ(α/W) ηζρύεη όηη, όηαλ ν ιόγνο α/W 

πξνζεγγίδεη ην κεδέλ (δειαδή, ζηελ πεξίπησζε πνιύ επξέσλ επηπέδσλ θαη 
κηθξώλ ξσγκώλ), ε ηηκή ηεο Τ(α/W) πξνζεγγίδεη ηελ κνλάδα. Παξαδείγκαηνο 

ράξε, γηα κία επίπεδε πιάθα απείξνπ πιάηνπο κε δηακπεξή ξσγκή ζην 
εζσηεξηθό ηεο (΢ρήκα 1.4α) είλαη Τ(α/W) = 1.0. Δλώ γηα κία επίπεδε πιάθα 

εκη-απείξνπ πιάηνπο κε ξσγκή κήθνπο α ζηε κία αθξαία πιεπξά ηνπ (΢ρήκα 
1.4β) είλαη Y(α/W) = 1.1.  
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΢ρήκα 1.4: ΢ρεκαηηθή αλαπαξάζηαζε (α) εζσηεξηθήο ξσγκήο ζε επίπεδε πιάθα απείξνπ 

πιάηνπο θαη (β) ξσγκήο ζηελ άθξε επίπεδεο πιάθαο εκη-απείξνπ πάρνπο. (Σν ζρήκα έρεη 
παξζεί από William D. Callister Jr., Δπηζηήκε θαη ηερλνινγία ησλ πιηθώλ, 5ε έθδνζε, 

Δθδόζεηο Σδηόια, Θεζζαινλίθε 2004).  

 

 Δμ νξηζκνύ, ε αληίζηαζε ζξαύζεο (ή θξίζηκνο ζπληειεζηήο έληαζεο 

ηάζεο) είλαη ε ηδηόηεηα πνπ εθθξάδεη ηελ αληίζηαζε ηνπ πιηθνύ ζε ςαζπξή 
ζξαύζε όηαλ ππάξρεη ξσγκή. Οη κνλάδεο ηεο είλαη νη ίδηεο κε απηέο ηνπ 

ζπληειεζηή έληαζεο ηάζεσλ (δειαδή, Ν/mm
2

mm  ή psi m ). 

 ΢ε ζρεηηθά ιεπηά δνθίκηα, ε ηηκή ηνπ Kc εμαξηάηαη από ην πάρνο ηνπ 
δνθηκίνπ θαη κάιηζηα κεηώλεηαη όζν απηό απμάλεη. Σειηθά, ηo Kc γίλεηαη 

αλεμάξηεην ηνπ δνθηκίνπ από ηε ζηηγκή πνπ ε ζπλζήθε ηεο θαηάζηαζεο 
επίπεδεο παξακόξθσζεο εθπιεξώλεηαη. Ζ ζηαζεξή ηηκή ηνπ Kc γηα ηα 

πεξηζζόηεξν παρηά δνθίκηα είλαη γλσζηή σο θξίζηκνο ζπληειεζηήο έληαζεο 
ηάζεο ζε θαηάζηαζε επίπεδεο παξακόξθσζεο KΗc, πνπ νξίδεηαη επίζεο σο εμήο:  

 

IcK Y     (1.6)  

 

Ο δείθηεο Η ηνπ KΗc ππνδειώλεη όηη ε ζπγθεθξηκέλε θξίζηκε ηηκή ηνπ Κ 
αληηζηνηρεί ζε κεηαηόπηζε ξσγκήο ηνπ ηύπνπ Η (΢ρήκα 2α). Σα ςαζπξά πιηθά, 

ζηα νπνία δελ είλαη δπλαηόλ λα παξνπζηαζζεί ζεκαληηθή πιαζηηθή 
παξακόξθσζε κπξνζηά από κία εμειηζζόκελε ξσγκή, έρνπλ ρακειέο ηηκέο ηνπ 

KΗc θαη είλαη εππαζή ζε θαηαζηξεπηηθή αζηνρία. Από ηελ άιιε κεξηά, νη ηηκέο 
ηνπ KΗc ζηα όιθηκα πιηθά είλαη ζρεηηθά πςειέο. Ζ κεραληθή ηεο ζξαύζεο είλαη 

ηδηαίηεξα ρξήζηκε ζηελ πξόβιεςε θαηαζηξνθηθώλ αζηνρηώλ ζε πιηθά κε 
ελδηάκεζε νιθηκόηεηα.  
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 Ο ζπληειεζηήο έληαζεο ηάζεο Κ θαη ν θξίζηκνο ζπληειεζηήο έληαζεο 

ηάζεο ζε θαηάζηαζε επίπεδεο παξακόξθσζεο KΗc ζρεηίδνληαη κεηαμύ ηνπο κε 
ηνλ ίδην ηξόπν όπσο ε ηάζε θαη ην όξην δηαξξνήο. Κάζε πιηθό κπνξεί λα 
ππόθεηηαη ζε πνιιέο ηηκέο ηάζεο, ππάξρεη όκσο έλα ζπγθεθξηκέλν επίπεδν 

ηάζεο ζην νπνίν ην πιηθό παξακνξθώλεηαη πιαζηηθά - απηό είλαη ην όξην 
δηαξξνήο. Παξόκνηα, έλαο κεγάινο αξηζκόο ηηκώλ ηνπ Κ είλαη δπλαηόο, όκσο ην 

KΗc είλαη κνλαδηθό γηα ζπγθεθξηκέλν πιηθό θαη ππνδειώλεη ηηο ζπλζήθεο ηεο 
αηέιεηαο, ην κέγεζνο θαη ηελ αλαγθαία ηάζε γηα λα επέιζεη ςαζπξή ζξαύζε.  

 Αξθεηέο δηαθνξεηηθέο ηερληθέο δνθηκήο ρξεζηκνπνηνύληαη γηα ηε κέηξεζε 

ηνπ KΗc. Οπζηαζηηθά, δνθίκηα θάζε κεγέζνπο θαη ζρήκαηνο, ζπκβαηνύ κε ηνλ 
ηύπν Η κεηαηόπηζεο ησλ ξσγκώλ, κπνξνύλ λα ρξεζηκνπνηεζνύλ θαη αθξηβείο 

κεηξήζεηο ζα θαηαγξαθνύλ κε ηελ πξνϋπόζεζε όηη ε θιίκαθα ηεο παξακέηξνπ 
Τ ζηελ Δμίζσζε 1.6 έρεη πξνζδηνξηζζεί ζσζηά.  
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΢ρήκα 1.5: Σξόπνη ππνινγηζκνύ ηνπ Τ ηξηώλ απιώλ γεσκεηξηώλ πιάθαο-ξσγκήο. (Σν ζρήκα 

έρεη παξζεί από David Broek, The practical use of Fracture Mechanics Copyright © 1988 

Kluwer Academic Publishers, Netherlands). 

 

1.4 ΟΓΟΝΣΧΣΟΗ ΣΡΟΥΟΗ  

 

Οη νδνλησηνί ηξνρνί ρξεζηκνπνηνύληαη ζε κεγάιν βαζκό γηα ηε κεηάδνζε 
ηεο ηζρύνο ή θίλεζεο κεηαμύ αμόλσλ (αηξάθησλ). Ζ κεηάδνζε απηή γίλεηαη κε 

ηελ εκπινθή ησλ δνληηώλ ελόο νδνλησηνύ ηξνρνύ, πνπ νλνκάδεηαη θηλεηήξηνο 
ηξνρόο, κε έλα ζπλεξγαδόκελν νδνλησηό ηξνρό. 
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Πιενλεθηήκαηα νδνλησηώλ ηξνρώλ: 

 κηθξή απαηηνύκελε ζπληήξεζε  

 αζθάιεηα ιεηηνπξγίαο θαη κεγάιε δηάξθεηα δσήο  

 αθξηβήο ζρέζε κεηάδνζεο  

 κεγάινο βαζκόο απόδνζεο  

 δπλαηόηεηα ππεξθόξηηζεο  

 θαηαιακβάλνπλ κηθξόηεξν ρώξν έλαληη ησλ ηκάλησλ θαη ησλ 
αιπζίδσλ.  

 

Μεηνλεθηήκαηα νδνλησηώλ ηξνρώλ: 

 κεγάιν θόζηνο θαηαζθεπήο  

 ζνξπβώδεο ιεηηνπξγία 

 κε ειαζηηθή κεηαθνξά ησλ δπλάκεσλ.  

 

Ζ ζέζε ησλ αηξάθησλ πνπ ζπλδένληαη κε νδνληνθίλεζε κπνξεί λα είλαη 
ηπραία ζην ρώξν. Αλάινγα κε ηελ εμσηεξηθή ηνπο κνξθή νη νδνλησηνί ηξνρνί 

(γξαλάδηα) δηαθξίλνληαη ζε κεησπηθνύο, θσληθνύο θαη ζε αηέξκνλεο θνριίεο 
(΢ρήκα 1.6). 

 

 

΢ρήκα 1.6: Γηάθνξα είδε νδνλησηώλ ηξνρώλ. 

 

Οη κεησπηθνί νδνλησηνί ηξνρνί έρνπλ θπιηλδξηθή κνξθή κε δόληηα πνπ 
βξίζθνληαη ζηελ εμσηεξηθή ηνπο πεξηθέξεηα. 

Οη θσληθνί νδνλησηνί ηξνρνί έρνπλ θσληθή κνξθή κε δόληηα πνπ 
βξίζθνληαη ζηελ εμσηεξηθή ηνπο παξάπιεπξε επηθάλεηα θαη ρξεζηκνπνηνύληαη 

γηα λα κεηαθέξνπλ ηζρύ κεηαμύ αηξάθησλ ησλ νπνίσλ νη άμνλεο ηέκλνληαη. Οη 



 

 

11 

άμνλεο απηνί κπνξνύλ λα ηέκλνληαη ζε νπνηαδήπνηε γσλία αιιά ζπρλόηεξα 

παξνπζηάδνληαη ζε γσλία 90°. 

Δηδηθή πεξίπησζε θσληθώλ νδνλησηώλ ηξνρώλ κε ηνμνεηδή νδόλησζε 

είλαη νη ππνεηδείο ηξνρνί ησλ νπνίσλ νη άμνλέο ηνπο δελ ηέκλνληαη αιιά είλαη 
αζύκβαηνη. 

Δπίζεο αλάινγα κε ηελ πνξεία ηεο θαηαλνκήο ηνπ νδόληα δηαθξίλνπκε 

νδόληεο επζείο, θεθιηκέλνπο, γσληώδεηο, ηνμσηνύο, ζπεηξνεηδείο θαη εμειηγκέλεο 
(΢ρήκα 1.7α έσο ζη).   

 

 

΢ρήκα 1.7: Μνξθέο θαηαλνκήο ηνπ νδόληα. Οδόληεο (α) επζείο, (β) θεθιηκέλνη, (γ) 
γσληώδεηο, (δ) ηνμσηνί, (ε) ζπεηξνεηδείο, (ζη) εμειηγκέλεο [(δ), (ε) θαη (ζη) δίλνπλ ηε κνξθή 

νδόλησζεο ζε επίπεδν θσληθό ηξνρό]. (Σν ζρήκα έρεη παξζεί από Ησάλλεο Κ. ΢ηεξγίνπ, 

Κσλζηαληίλνο Η. ΢ηεξγίνπ, ΢ηνηρεία Μεραλώλ ΗΗ. ΢ύγρξνλε Δθδνηηθή, Αζήλα 2002).   

 

1.4.1 Υαξαθηεξηζηηθά κεγέζε ηωλ νδνληωηώλ ηξνρώλ 

 

Πξνθεηκέλνπ έλαο νδνλησηόο ηξνρόο λα ζπλεξγάδεηαη κε έλαλ άιιν θαη 

λα κελ ππάξρεη αζπλέρεηα ζηε κεηάδνζε ηεο θίλεζεο, ηα δόληηα ηνπ πξέπεη λα 
έρνπλ ην ίδην ύςνο, ην ίδην πάρνο, ηελ ίδηα απόζηαζε κεηαμύ ηνπο θαη ηελ ίδηα 

κνξθή. Οη άμνλεο σο πξνο ηνπο νπνίνπο πεξηζηξέθνληαη δύν ζπλεξγαδόκελνη 
νδνλησηνί ηξνρνί κπνξεί λα είλαη παξάιιεινη, ηεκλόκελνη ππό γσλία ή 

αζύκβαηνη. Ο πην απιόο γεσκεηξηθά νδνλησηόο ηξνρόο είλαη ν κεησπηθόο 
ηξνρόο κε επζεία δόληηα. 

Έηζη, θάπνηα από ηα βαζηθά ραξαθηεξηζηηθά κεγέζε ελόο νδνλησηνύ 
ηξνρνύ θαίλνληαη παξαθάησ (΢ρήκα 1.8) θαη είλαη αλαιπηηθά ηα εμήο: 
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΢ρήµα 1.8: Βαζηθά κεγέζε νδνλησηώλ ηξνρώλ µε επζείο νδόληεο. 

 

 

• Γηάµεηξνο αξρηθνύ θύθινπ ή θύθινπ θύιηζεο d0 νλνµάδεηαη ε 
δηάµεηξνο ηνπ θύθινπ ζηνλ νπνίν εθάπηεηαη ν έλαο θύιηλδξνο πάλσ ζηνλ άιιν. 

Δίλαη επίζεο ν θύθινο πνπ ρξεζηκνπνηείηαη γηα ηελ θαηαζθεπή ηνπ νδνλησηνύ 
ηξνρνύ δειαδή ν θύθινο πάλσ ζηνλ νπνίν θπιίεηαη ην θνπηηθό εξγαιείν. 

 

• Module ή κέηξν m νλνκάδεηαη ν ιόγνο p/π (ή ην κήθνο ηεο αξρηθήο 
δηακέηξνπ πνπ αληηζηνηρεί ζε έλα δόληη) 

0dp
m

z
      ζε  mm  (1.7) 

Όπνπ, p ην βήκα, do ε δηάκεηξνο αξρηθνύ θύθινπ θαη z ν αξηζκόο δνληηώλ ηνπ 

γξαλαδηνύ. 

 

• ΢ρέζε µεηάδνζεο i νλνµάδεηαη ν ιόγνο ηνπ αξηζµνύ ησλ ζηξνθώλ nα (ή 

ηεο γσληαθήο ηαρύηεηαο σα) ηνπ θηλεηήξηνπ (πξώηνπ) ηξνρνύ πξνο ηνλ αξηζµό 
ζηξνθώλ nb (ή ηεο γσληαθήο ηαρύηεηαο σb) ηνπ θηλνύκελνπ (ηειεπηαίνπ) 

ηξνρνύ.  
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b b

n
i

n

 


        

Γηα λα ππάξρεη ζην δεύγνο ησλ ηξνρώλ ζπλερήο επαθή κε θύιηζε, ρσξίο 

νιίζζεζε, πξέπεη νη πεξηθεξεηαθέο ηαρύηεηεο ζηνπο αξρηθνύο θύθινπο λα είλαη 
ίζεο, επνκέλσο:  

1 1 2 2
1 2

60 60

d n d n 
 

   
      

θαη 

1 2

2 1

n d
i

n d
       

 

Δπεηδή d2 = m ∙ z2 θαη d1 = m ∙ z1 (από ζρέζε 1.7) ζα έρνπκε αθόκα:  

2 2

1 1

d z

d z
      

Ο ιόγνο ηνπ αξηζκνύ νδόλησλ z2/z1 ραξαθηεξίδεηαη κε ην γξάκκα u, δειαδή: 

2

1

1
z

u
z
       

 

ζα έρνπκε ινηπόλ ζρέζε κεηάδνζεο γηα κείσζε ζηξoθώλ i=u θαη ζρέζε 
κεηάδνζεο γηα αύμεζε ζηξνθώλ  i=1/u, όπνπ: 

π1,  π2: ε πεξηθεξεηαθή ηαρύηεηα ηνπ θηλεηεξίνπ θαη ηνπ θηλνπκέλνπ ηξνρνύ  

d1, d2: ε δηάκεηξνο αξρηθνύ θύθινπ ηνπ θηλεηεξίνπ θαη ηνπ θηλνπκέλνπ ηξνρνύ 

 z1, z2 : ν αξηζκόο νδόλησλ ηνπ κηθξνύ θαη ηνπ κεγάινπ ηξνρνύ.  

 

 

• Βήκα p νλνκάδεηαη ε απόζηαζε αλάκεζα ζε δύν αληίζηνηρα ζεκεία δύν 
γεηηνληθώλ δνληηώλ, όηαλ απηή ε απόζηαζε κεηξείηαη πάλσ ζηελ αξρηθή 

πεξηθέξεηα.  

d
p

z


   ,  ζε  mm  
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Γηα λα πεξηνξηζηεί ν αξηζκόο ησλ απαηηνπκέλσλ θνπηηθώλ εξγαιείσλ ζηε 

βηνκεραλία, ρξεζηκνπνηνύληαη ηα ηππνπνηεκέλα module πνπ πεξηέρνληαη ζηνλ 
Πίλαθα 1.1.  

 

Πίλαθαο 1.1: Σηµέο module ζε mm θαηά DIΝ 780. 

΢
εη

ξ
ά

 1
 0.05 0.06 0.08 0.10 0.12 0.16 0.20 0.25 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1 1.25 

1.5 2 2.5 3 4 5 6 8 10 12 16 20 25 32 40 50 60 

΢
εη

ξ
ά

 2
 0.055 0.07 0.09 0.11 0.14 0.18 0.22 0.28 0.35 0.45 0.55 0.65 0.75 0.85 0.95 1.125 1.375 

1.75 2.25 2.75 3.5 4.5 5.5 7 9 11 14 18 22 28 36 45 55 70 

 

 

• Ύςνο θεθαιήο hα νλνκάδεηαη ε αθηηληθή απόζηαζε κεηαμύ αξρηθνύ 

θύθινπ θαη θύθινπ θεθαιήο. Λακβάλεηαη ίζν κε ην module: 

h m       

• Ύςνο πόδα hf νλνκάδεηαη ε αθηηληθή απόζηαζε κεηαμύ αξρηθνύ θύθινπ 
θαη θύθινπ πόδα. Λακβάλεηαη ίζν κε 1,167m ή 1,25m αλάινγα κε ην θνπηηθό 

εξγαιείν: 

1,167fh h c m c m          

1,25fh h c m c m         

c είλαη ε ράξε θεθαιήο, δειαδή ε ράξε αλάκεζα ζηνπο θύθινπο θεθαιήο θαη 

πόδα θαη αλάινγα κε ην θνπηηθό εξγαιείν ιακβάλεηαη σο c = 0,167m ή 
ζπλεζέζηεξα c = 0,25m.  

 

• Ύςνο νδόληα h νλνκάδεηαη ην άζξνηζκα ηνπ ύςνπο θεθαιήο θαη ύςνπο 
πόδα:  

fh h h     

 

• Γηάκεηξνο θύθινπ θεθαιήο dα νλνκάδεηαη ε δηάκεηξνο ηνπ θύθινπ πνπ 

πεξηνξίδεη εμσηεξηθά ηνπο νδόληεο:  

2d d h         
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• Γηάµεηξνο θύθινπ πόδα df νλνµάδεηαη ε δηάµεηξνο ηνπ θύθινπ πνπ 

πεξηνξίδεη εζσηεξηθά ηνπο νδόληεο:  

2f fd d h       

• Απόζηαζε αμόλσλ αd νλνµάδεηαη ην εµηάζξνηζµα ησλ δηαµέηξσλ ησλ 
αξρηθώλ θύθισλ:  

1 2 1 2( )

2 2
d

d d m z z


 
      

• Πάρνο νδόλησλ s µεηξάηαη πάλσ ζηνλ αξρηθό θύθιν θαη είλαη s = p-e, 

όπνπ e ην δηάθελν µεηαμύ δύν νδόλησλ θαη νξίδεηαη σο ε δηαθνξά ηνπ 
βήκαηνο από ην πάρνο ηνπ δνληηνύ. 

 

Σν πάρνο s θαη ην δηάθελν e εμαξηώληαη από ηελ θαηεξγαζία ησλ νδόλησλ θαη 

ηα µεγέζε ηνπο έρνπλ σο εμήο:  

 

γηα αθαηέξγαζηνπο νδόληεο 
19

40
s p    

21

40
e p

 

 

γηα θαηεξγαζµέλνπο νδόληεο 
39

80
s   ή 

79

160
 ή 

1

2
p   

41

80
e   ή 

81

160
 ή 

1

2
p  

 

΢ηνλ παξαθάησ Πίλαθα 1.2 δίλνληαη ζπλνπηηθά ραξαθηεξηζηηθά µεγέζε ησλ 
νδνλησηώλ ηξνρώλ. 

 

Πίλαθαο 1.2: Υαξαθηεξηζηηθά µεγέζε νδνλησηώλ ηξνρώλ.  

da Γηάκεηξνο θύθινπ 

θεθαιήο 

2ad d m   

d Γηάκεηξνο αξρηθνύ 

θύθινπ 
d m z   

df Γηάκεηξνο θύθινπ πόδα 2 1,16fd d m    

b Πιάηνο νδόληα - 
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p Βήκα d
p

z
  

s Πάρνο νδόλησλ s p e   

e Γηάθελν κεηαμύ ησλ 

νδόλησλ 

- 

ha Ύςνο θεθαιήο 
ah m  

hf Ύςνο πόδα 1,16fh m  

ad Απόζηαζε αμόλσλ  1 21 2

2 2
d

m z zd d
a


   

 

 

1.4.2 Βαζηθόο λόκνο ηεο νδόληωζεο  

 

Πξνϋπόζεζε γηα ηελ θαλνληθή (νµνηόµνξθε) ιεηηνπξγία ελόο δεύγνπο 
νδνλησηώλ ηξνρώλ είλαη µία ζηαζεξή ζρέζε ησλ γσληαθώλ ηαρπηήησλ ηνπ θηλε-

ηεξίνπ θαη ηνπ θηλνπµέλνπ ηξνρνύ, δειαδή µία ζηαζεξή ζρέζε µεηάδνζεο.  

Ο βαζηθόο λόµνο ηεο νδόλησζεο ιέεη όηη: Γηα λα επηηεπρζεί ε νκνηόκνξθε 

κεηαθνξά ηεο θίλεζεο από ηνλ θηλεηήξην ηξνρό ζηνλ ζπλεξγαδόκελν (θύιηζε 
ησλ δύν ηξνρώλ ρσξίο νιίζζεζε) ζα πξέπεη νη θάζεηεο ζην θάζε ζεκείν επαθήο 

ησλ ζπλεξγαδόκελσλ ηξνρώλ λα πεξλνύλ από ην ζεκείν (θέληξν) θύιηζεο C.  

Γηα λα πξνζδηνξηζηεί ε δηεύζπλζε ηεο δύλακεο κεηαμύ ησλ νδόλησλ, ζην 
ζεκείν Β (΢ρήµα 1.9) θέξνπκε ηελ θνηλή εθαπηνκέλε tBt θαη πάλσ ζε απηή ηελ 
θάζεην nΒn πνπ ηέµλεη ηε δηάθεληξν Μ1Μ2 ζην ζεµείν C. Ζ κεηαθνξά ηεο 

δύλαµεο κεηαμύ ησλ νδόλησλ κπνξεί λα γίλεη µόλν θαηά κήθνο ηεο επζείαο 
nBn.  
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΢ρήµα 1.9: Βαζηθόο λόµνο ηεο oδόvησζεο. (Σν ζρήκα έρεη παξζεί από Ησάλλεο Κ. ΢ηεξγίνπ, 

Κσλζηαληίλνο Η. ΢ηεξγίνπ, ΢ηνηρεία Μεραλώλ ΗΗ. ΢ύγρξνλε Δθδνηηθή, Αζήλα 2002). 

 

1.5 ΔΠΑΦΖ HERTZ 

 

Όηαλ δύν εκπιεθόκελα ζώκαηα ζπκπηέδνληαη κε θάπνηα δύλακε, 

πξνθύπηεη ηνπηθά κία επηθάλεηα επαθήο ιόγσ παξακνξθσζηκόηεηαο ησλ δύν 
ζσκάησλ. Σν κέγεζνο ηεο επηθάλεηαο απηήο εμαξηάηαη από ηε δύλακε θαη ηε 

ζηηβαξόηεηα ησλ ζσκάησλ. Απηό είλαη αληίζηνηρν κε ην λα πηέδεη θάπνηνο ην 
δάρηπιό ηνπ ζε έλα ηδάκη. Ακέζσο ζα δεκηνπξγεζεί κία επηθάλεηα επαθήο, 

ιόγσ ηεο ηνπηθήο παξακόξθσζεο ηνπ δάρηπινπ (ζεσξώληαο ην ηδάκη ηνπηθά 
απαξακόξθσην, δειαδή απείξσο ζηηβαξόηεξν από ην δάρηπιν).  Όηαλ ιέκε όηη 

νη επηθάλεηεο πηέδνπλ ε κία ηελ άιιε, ελλννύκε όηη ε πξώηε αζθεί κία δύλακε 
ζηε δεύηεξε θαη ε δεύηεξε αζθεί κία δύλακε αληίδξαζεο ζηελ πξώηε. 

 ΢ύκκνξθεο επηθάλεηεο νλνκάδνληαη νη επηθάλεηεο ησλ νπνίσλ ε 
γεσκεηξία επηηξέπεη κεγάιε επηθάλεηα επαθήο. Γύν νκόθεληξνη θύθινη κε 

κηθξή δηαθνξά ζηελ αθηίλα ηνπο είλαη ζύκκνξθεο επηθάλεηεο. Κιαζηθό 
παξάδεηγκα είλαη έλα θνπδηλέην, όπνπ έρνπκε έλα δαθηύιην κε αθηίλα R θαη 

έλαλ εμσηεξηθό δαθηύιην κε ιίγν κεγαιύηεξε αθηίλα. 

 Με ζύκκνξθεο επηθάλεηεο νλνκάδνληαη νη επηθάλεηεο ησλ νπνίσλ ε 

γεσκεηξία απαγνξεύεη ηελ κεγάιε επηθάλεηα επαθήο. Αλ γηα παξάδεηγκα νη δύν 
πξνεγνύκελνη νκόθεληξνη θύθινη απνθηήζνπλ κεγάιε δηαθνξά ζηηο αθηίλεο 
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ηνπο, ζεσξνύληαη κε ζύκκνξθεο επηθάλεηεο. Σέηνηα πεξίπησζε είλαη ε κπίιηα 

ελόο ξνπιεκάλ πνπ έρεη αθηίλα θακππιόηεηαο πνιύ κηθξόηεξε από ηελ αθηίλα 
θακππιόηεηαο ηνπ δαθηπιίνπ πνπ ηε θηινμελεί. Δπίζεο, κε ζύκκνξθεο 
επηθάλεηεο δεκηνπξγνύληαη θαη όηαλ κία θνίιε κε κία θπξηή επηθάλεηα έξρνληαη 

ζε επαθή. Κιαζηθό παξάδεηγκα απηήο ηεο θαηεγνξίαο είλαη ε εκπινθή ησλ 
παξεηώλ δύν δνληηώλ ελόο δεύγνπο νδνλησηώλ ηξνρώλ (΢ρήκα 1.10). 

 

 

 

 

 

            

΢ρήκα 1.10: Εεύγε νδνλησηώλ ηξνρώλ 

 

Δύθνια κπνξεί λα ππνζέζεη θαλείο όηη ε επηθάλεηα επαθήο κεηαμύ δύν κε 
ζύκκνξθσλ επηθαλεηώλ είλαη πνιύ κηθξόηεξε από ηελ επηθάλεηα επαθήο κεηαμύ 
δύν ζύκκνξθσλ, εθαξκόδνληαο θαη ζηηο δύν ην ίδην θνξηίν. Απηό έρεη άκεζν 

αληίθηππν ζηελ πίεζε πνπ αλαπηύζζεηαη κεηαμύ ηνπο. 

΢ηηο ζύκκνξθεο αλαπηύζζνληαη πηέζεηο ηεο ηάμεο ησλ MPa ζηελ 
επηθάλεηα επαθήο, ελώ ζηηο κε ζύκκνξθεο πηέζεηο ηεο ηάμεο ησλ GPa. 

Ο Heinrich Hertz (1857-1894) αλέπηπμε κία ζεσξία βάζεη ηεο νπνίαο 
κπνξεί λα ππνινγηζηεί ην εκβαδό ηεο επηθάλεηαο επαθήο κεηαμύ δύν κε 

ζύκκνξθσλ επηθαλεηώλ πνπ ππόθεηληαη ζε θόξηηζε. Ζ θόξηηζε απηή πξνθαιεί 
ηνπηθή ειαζηηθή παξακόξθσζε. Έηζη ε επηθάλεηα επαθήο εμαθαλίδεηαη όηαλ 

αξζεί ε θόξηηζε, όπσο εμαθαλίδεηαη θαη ε παξακόξθσζε ζην δάρηπιό καο όηαλ 
ην απνκαθξύλνπκε από ην ηδάκη. Ζ επηθάλεηα απηή κπνξεί λα έρεη δύν πηζαλά 

ζρήκαηα, αλάινγα ην είδνο ηεο κε ζύκκνξθεο γεσκεηξίαο. ΢ηηο κε ζύκκνξθεο 
επηθάλεηεο ινηπόλ πθίζηαληαη δύν είδε επαθήο: 

  

α) ε ζεκεηαθή επαθή 

β) ε γξακκηθή επαθή   
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΢εκεηαθή επαθή ππάξρεη όηαλ π.ρ. δύν ζθαίξεο έξζνπλ ζε επαθή. Όηαλ 

δύν επηθάλεηεο κε ζύκκνξθεο δεκηνπξγνύλ ζεκεηαθή επαθή, ην ζρήκα ηεο 
επηθάλεηαο επαθήο ηνπο ζα είλαη κία έιιεηςε. Ζ εθθεληξόηεηα ηεο έιιεηςεο 
θαζνξίδεηαη από ηα επηκέξνπο γεσκεηξηθά ζηνηρεία ησλ επηθαλεηώλ. Αλ ηα δύν 

αληηθείκελα είλαη ζθαίξεο, ε πξνθύπηνπζα εθθεληξόηεηα είλαη κεδεληθή, νπόηε 
ε έιιεηςε γίλεηαη θύθινο. 

Παξαθάησ θαίλεηαη κία ζεκεηαθή επαθή κεηαμύ ζθαηξώλ ζε αλαπαξάζηαζε 3D 

(΢ρήκα 1.11). Ζ πεξηνρή επαθήο (θόθθηλν ρξώκα) ησλ δύν απηώλ ζθαηξώλ 
ιόγσ παξακόξθσζεο ησλ ζσκάησλ θαη ππό ηελ επίδξαζε κηαο θόξηηζεο 

απνθηά ειιεηπηηθό ζρήκα κε κεδεληθή εθθεληξόηεηα (θύθινο). Οη δηαζηάζεηο 
(άξα θαη ην εκβαδόλ) ηεο επαθήο ππνινγίδνληαη από ηε ζεσξία ηνπ Hertz. 

΢εκεηαθή επαθή ζα είρακε θαη αλ κία ζθαίξα αθνπκπνύζε ζε έλα επίπεδν.    

 

 

΢ρήκα 1.11: ΢εκεηαθή επαθή κεηαμύ ζθαηξώλ. 

 

Γξακκηθή επαθή έρνπκε όηαλ π.ρ. έλαο θύιηλδξνο έξζεη ζε επαθή κε ην 

επίπεδν. Όηαλ νη κε ζύκκνξθεο επηθάλεηεο δεκηνπξγνύλ γξακκηθή επαθή, ην 
ζρήκα ζα είλαη έλα νξζνγώλην. Ζ κία ηνπ πιεπξά ζα είλαη ίζε κε ηελ ειαζηηθή 
δηαπιάηπλζε εμαηηίαο ηεο θόξηηζεο (ιόγσ παξακνξθσζηκόηεηαο) θαη ε άιιε ζα 

είλαη ίζε κε ην πιάηνο ηνπ θπιίλδξνπ ή γεληθόηεξα ησλ ζσκάησλ πνπ έξρνληαη 
ζε επαθή. 

 Παξαθάησ δηαθξίλεηαη κία πεξίπησζε γξακκηθήο επαθήο ζε απιή 

αλαπαξάζηαζε 3D (΢ρήκα 1.12). Παξηζηάλνληαη δύν νδνλησηνί ηξνρνί κε ίζηα 
δόληηα ζε ζηηγκηόηππν εκπινθήο. Φαίλεηαη κόλν έλα δόληη ζε θάζε ηξνρό γηα 
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επθξίλεηα. Ζ κπιε πεξηνρή είλαη ε γξακκηθή επηθάλεηα επαθήο. ΢ηελ 

πξαγκαηηθόηεηα είλαη πνιύ πην ιεπηή απηή ε νξζνγσληθνύ ζρήκαηνο επαθή, 
ιόγσ πνιύ κηθξόηεξεο ειαζηηθήο δηαπιάηπλζεο. Ζ εηθόλα απηή δείρλεη έλα 
ζηηγκηόηππν εκπινθήο δνληηώλ, αθνύ ηελ επόκελε ρξνληθή ζηηγκή ηεο εκπινθήο 

ε επηθάλεηα επαθήο ζα αιιάμεη ζέζε θαη κέγεζνο σο πξνο ηα δόληηα. 

 Σν εκβαδόλ ηεο πεξηνρήο απηήο βξίζθεηαη, όπσο θαη πξηλ, από ηελ ζεσξία 
ηνπ Hertz. Ζ πξάζηλε θαη θόθθηλε γξακκή θαλνληθά είλαη κε νξαηέο, αιιά ζην 

ζρέδην θαίλνληαη πάιη γηα επθξίλεηα.       

 

 

΢ρήκα 1.12: Γξακκηθή επαθή δύν νδνλησηώλ ηξνρώλ κε ίζηα δόληηα ζε ζηηγκηόηππν 

εκπινθήο.  

 

1.6  ΤΠΟΛΟΓΗ΢ΜΟ΢ ΣΟΤ ΟΓΟΝΣΑ ΢Δ ΠΗΔ΢Ζ ΔΠΗΦΑΝΔΗΑ΢  

 

Ο ππνινγηζκόο ζε πίεζε επηθαλείαο κε βάζε ηνλ ηύπν ηνπ Hertz 

αλαθέξεηαη ζηελ πίεζε κεηαμύ δύν αθίλεησλ θπιίλδξσλ (΢ρήκα 1.13).  

Αλ δύν θύιηλδξνη µε αθηίλεο ξ1 θαη ξ2 θαη πιάηνο b, θνξηηζζνύλ µε µία 
θάζεηε δύλακε F, ζηε δώλε πίεζεο ζα εκθαληζζεί ειιεηπηηθή θαηαλνκή ησλ 

ηάζεσλ.  

Ζ µέγηζηε πίεζε (πίεζε Hertz) ζα είλαη:  

 

0,418
e

F E

L








    ζε  Ν/mm
2
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Όπνπ:  

Δ = κέηξν ειαζηηθόηεηαο 

L = κήθνο γξακκήο επαθήο 

ξe = ηζνδύλακε αθηίλα θακππιόηεηαο (mm), πνπ είλαη: 

 

1 2

1 2

e

 


 



  

 

Σν εκβαδόλ ηεο πεξηνρήο επαθήο δίλεηαη από ηνλ ηύπν: 

 

3.04 n e
c

F
b

LE




 

 

 

 

΢ρήµα 1.13: Πίεζε µεηαμύ δύν θπιίλδξσλ. (Σν ζρήκα έρεη παξζεί από Ησάλλεο Κ. ΢ηεξγίνπ, 

Κσλζηαληίλνο Η. ΢ηεξγίνπ, ΢ηνηρεία Μεραλώλ ΗΗ. ΢ύγρξνλε Δθδνηηθή, Αζήλα 2002). 
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΢ρήµα 1.14: Πίεζε µεηαμύ δύν νδόλησλ. (Σν ζρήκα έρεη παξζεί από Ησάλλεο Κ. ΢ηεξγίνπ, 

Κσλζηαληίλνο Η. ΢ηεξγίνπ, ΢ηνηρεία Μεραλώλ ΗΗ. ΢ύγρξνλε Δθδνηηθή, Αζήλα 2002). 

 

΢ην ΢ρήκα 1.14 απεηθνλίδνληαη δύν νδνλησηνί ηξνρνί. Ζ κέγηζηε πίεζε θαηά 

Hertz θαη ην εκβαδόλ ηεο πεξηνρήο επαθήο ππνινγίδεηαη όπσο αθξηβώο θαη γηα 
ηνπο θπιίλδξνπο ζην ΢ρήκα 1.13. 

 

1.7 ΜΔΘΟΓΟ΢ ΠΔΠΔΡΑ΢ΜΔΝΧΝ ΢ΣΟΗΥΔΗΧΝ 

 

    Παιηόηεξα κπνξνύζαλ λα αλαιπζνύλ κόλν νη εμηζώζεηο ηερληθώλ 
πξνβιεκάησλ, ησλ νπνίσλ ηα γεσκεηξηθά ζρήκαηα θαη νη θαηαπνλήζεηο ήηαλ 

απιά. Δπεηδή όκσο ππήξρε ε ζέιεζε λα ιπζνύλ πην ζύλζεηα πξνβιήκαηα, 
αλαπηύρζεθαλ δηάθνξεο πξνζεγγηζηηθέο κέζνδνη. Μία από απηέο είλαη θαη ε 

κέζνδνο ησλ πεπεξαζκέλσλ ζηνηρείσλ. Ο ηξόπνο κε ηνλ νπνίν επηιύνληαη 
πξνβιήκαηα κε ηε ρξήζε ησλ πεπεξαζκέλσλ ζηνηρείσλ εθαξκόδεηαη παξόκνηα 
ζε παγθόζκηα θιίκαθα. Ζ δηαδηθαζία γηα ηελ αλάιπζε κηαο θαηαζθεπήο είλαη ε 

εμήο: πξώηα ζρεδηάδνπκε ηελ θαηαζθεπή θαη ζηε ζπλέρεηα ηελ ρσξίδνπκε 
(δηαθξηηνπνηνύκε) ζε κηθξά γεσκεηξηθά ζρήκαηα, όπσο ηεηξάπιεπξα ή ηξίγσλα, 

ηα νπνία νλνκάδνληαη πεπεξαζκέλα ζηνηρεία. Σα πεπεξαζκέλα ζηνηρεία έρνπλ 
ηελ δπλαηόηεηα λα εμεηάδνπλ ηηο ηδηόηεηεο ηνπ πιηθνύ θαη ηηο εμηζώζεηο πνπ ην 

ραξαθηεξίδνπλ σο ζπλάξηεζε ησλ αγλώζησλ κεηαηνπίζεσλ ζηηο θνξπθέο ηνπ 
πεπεξαζκέλνπ ζηνηρείνπ (κέζνδνο ησλ κεηαηνπίζεσλ). Αθνύ ιεθζνύλ ππόςε 

ηηο νξηαθέο ζπλζήθεο αιιά θαη ηα θνξηία (κεραληθά θαη ζεξκηθά) θαηαιήγνπκε 
ζηηο εμηζώζεηο ηζνξξνπίαο ηεο θαηαζθεπήο. Ζ δεηνύκελε ιύζε πξνθύπηεη θαηά 
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πξνζέγγηζε από ηελ επίιπζε ηνπ ζπζηήκαηνο ησλ εμηζώζεσλ σο πξνο ηνπο 

αγλώζηνπο, νη νπνίνη είλαη νη θνκβηθέο κεηαηνπίζεηο. Αλ γλσξίδνπκε ηηο 
θνκβηθέο κεηαηνπίζεηο κπνξνύκε λα ππνινγίζνπκε ζηα δηάθνξα ζεκεία ηεο 
θαηαζθεπήο ηηο παξακνξθώζεηο, ηηο ηάζεηο θαη ηηο αληηδξάζεηο ησλ ζηεξίμεσλ. 

Ζ κέζνδνο ησλ πεπεξαζκέλσλ ζηνηρείσλ, κε ηε βνήζεηα ηνπ ειεθηξνληθνύ 
ππνινγηζηή θαη ησλ ππνινγηζηηθώλ κεζόδσλ, δίλεη ηε δπλαηόηεηα ζηνπο 

επηζηήκνλεο λα ιύλνπλ πξνβιήκαηα πνπ ζεσξνύζαλ άιπηα, ζε πνιύ κηθξό 
ρξόλν. Ζ αλάγθε ηεο βηνκεραλίαο γηα επθνιόηεξε θαη γξεγνξόηεξε επίιπζε 

πξνβιεκάησλ ζηελ πξάμε, νδήγεζε ζηελ αλάπηπμε γξαθηθώλ πξνγξακκάησλ, 
ηα νπνία ζπλνδεύνπλ ηελ αλάιπζε-ππνινγηζκό πνπ παξέρνπλ ηα πεπεξαζκέλα 

ζηνηρεία. 

Απηόο ν ζπλδπαζκόο ησλ γξαθηθώλ πξνγξακκάησλ κε ηελ αλάιπζε-
ππνινγηζκό ησλ πεπεξαζκέλσλ ζηνηρείσλ θάλνπλ ηελ επηζηήκε πην απιή, πην 

πξνζηηή θαη πην δεκηνπξγηθή.  Ζ αλάπηπμε εκπνξηθώλ πξνγξακκάησλ γηα Ζ/Τ 
είλαη απνηέιεζκα ζπζηεκαηηθήο εξγαζίαο ησλ εξεπλεηώλ. Απηά ηα εκπνξηθά 

πξνγξάκκαηα ρσξίδνληαη ζε δύν κεγάιεο θαηεγνξίεο, ηα γξαθηθά θαη ηα 
πξνγξάκκαηα αλάιπζεο. 

Σα γξαθηθά πξνγξάκκαηα κπνξνύκε λα ηα ρξεζηκνπνηήζνπκε πξηλ ηελ 

αλάιπζε (pre-proccesing), αιιά θαη κεηά ηελ αλάιπζε (post-proccesing). 

 Pre-proccesing. Με ηε ρξήζε ηνπ γξαθηθνύ πξνγξάκκαηνο ην ζώκα ή ε 

θαηαζθεπή ζρεδηάδεηαη θαη ζηελ ζπλέρεηα ρσξίδεηαη  (δηαθξηηνπνηείηαη) 
ζηα πεπεξαζκέλα ζηνηρεία. 

 Post-proccesing. Μεηά ηελ αλάιπζε γίλνληαη γξαθηθέο παξαζηάζεηο ησλ 
απνηειεζκάησλ. Γηα παξάδεηγκα ε παξακόξθσζε ηνπ ζώκαηνο, ε 

θαηαλνκή ησλ ηάζεσλ εληόο ηνπ ζώκαηνο θαη άιια. 

΢ήκεξα, ηα πξνγξάκκαηα αλάιπζεο ρξεζηκνπνηνύληαη γηα ηε κειέηε πνηθίισλ 
πξνβιεκάησλ πνπ αθνξνύλ ζηε κεραληθή ησλ ζηεξεώλ ή ησλ θαηαζθεπώλ, ζηε 

θαηεξγαζία ησλ κεηάιισλ, ζηε κεηάδνζε ζεξκόηεηαο, ζηα ξεπζηά, ζηελ 
αθνπζηηθή, ζηνλ ειεθηξηζκό θαη ειεθηξνκαγλεηηζκό θαη ζε πνιιέο άιιεο 

εθαξκνγέο. Όιεο νη βηνκεραλίεο, νη ηερληθέο εηαηξίεο, ηα αλώηαηα ηδξύκαηα θαη 
ηα εξεπλεηηθά θέληξα ρξεζηκνπνηνύλ εκπνξηθά πξνγξάκκαηα γηα Ζ/Τ. Μεξηθά 

από απηά είλαη ηα εμήο: ANSYS, LUSAS, MasterSeries, PERMAS, FEM - 
Design, StressCheck, JMAG, Z88 θιπ. ΢ηε δηθή καο κειέηε ρξεζηκνπνηήζακε 

ην εκπνξηθό παθέην πεπεξαζκέλσλ ζηνηρείσλ ANSYS. 
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1.8 ΓΤΝΑΣΟΣΖΣΔ΢ ΠΡΟΓΡΑΜΜΑΣΟ΢ ANSYS 

 

Σν ANSYS είλαη από ηα θαιύηεξα θαη δεκνθηιέζηεξα πξνγξάκκαηα 
πεπεξαζκέλσλ ζηνηρείσλ πνπ πεξηέρεη πεξηζζόηεξεο από 100.000 γξακκέο 

θώδηθα. Δίλαη ηθαλό ζηελ αλάιπζε ξνήο ξεπζηώλ, ζηαηηθώλ, δπλακηθώλ 
πξνβιεκάησλ θαη ζηηο αλαιύζεηο ειεθηξνκαγλεηηζκνύ. Γηα λα κπνξέζεη 

θάπνηνο λα ρξεζηκνπνηήζεη ην ANSYS ή νπνηνδήπνηε άιιν πξόγξακκα 
πεπεξαζκέλσλ ζηνηρείσλ, πξέπεη λα έρεη ππόςε ηνπ θάπνηεο βαζηθέο έλλνηεο ηεο 

κεζόδνπ.    

 

 Πεξηζζόηεξεο ιεπηνκέξεηεο γηα ην ANSYS ζα βξείηε ζηελ πηπρηαθή 

εξγαζία κε ηίηιν «Μειέηε ζηαηηθήο επάξθεηαο ζπγθνιιεκέλσλ θαη 
εληζρπκέλσλ κε ξάβδνπο ηηηαλίνπ επηζηπιίσλ ηνπ ππν αλαζηήισζε λανύ ηνπ 

Γηόο ζηε Νεκέα» ησλ Μαγγαλά Παλαγηώηε θαη Καξαλάζνπ Παξαζθεπά ηνπ 
ηκήκαηνο Μεραλνινγίαο πνπ παξνπζηάζζεθε ην έηνο 2009. 
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ΚΔΦΑΛΑΗΟ 2 
 

 

ΔΠΗΛΤ΢Ζ ΥΑΡΑΚΣΖΡΗ΢ΣΖΚΧΝ ΠΡΟΒΛΖΜΑΣΧΝ ΜΔ ΣΖ 

ΥΡΖ΢Ζ ANSYS 

 

΢ην θεθάιαην απηό πεξηγξάθεηαη αλαιπηηθά ε επίιπζε ηεζζάξσλ 
ραξαθηεξηζηηθώλ παξαδεηγκάησλ κε ηελ ρξήζε ηνπ πξνγξάκκαηνο ANSYS, σο 

αληηπξνζσπεπηηθό δείγκα ησλ πξνβιεκάησλ πνπ επηιύζεθαλ ζην πιαίζην 
εθκάζεζεο ηνπ.  

 

2.1 ΑΝΑΛΤ΢Ζ ΔΠΗΠΔΓΖ΢ ΟΡΘΟΓΧΝΗΑ΢ ΠΛΑΚΑ΢ ΜΔ ΟΠΖ  

 

Έζησ κηα νξζνγώληα πιάθα δηαηάζεσλ 1000 mm x 400 mm θαη πάρνπο 
10 mm, ε νπνία είλαη θαηαζθεπαζκέλε από ηζόηξνπν νκνγελέο πιηθό κε κέηξν 

ειαζηηθόηεηαο Ε=207*10
3
 Ν/mm

2
 θαη ιόγν Poisson λ=0.29. ΢ην θέληξν ηεο 

πιάθαο ππάξρεη θπθιηθή νπή δηακέηξνπ 20mm, όπσο θαίλεηαη ζην ΢ρήκα 2.1. Ζ 
πιάθα δέρεηαη εθειθπζηηθέο ηάζεηο ζηα άθξα ηεο. ΢ηνλ Πίλαθα 2.1 πνπ 

αθνινπζεί αλαθέξνληαη όια ηα δεδνκέλα ηνπ πξνβιήκαηνο.  

 

΢ρήκα 2.1: Απεηθόληζε ηεο πιάθαο κε ηελ νπή. 
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Πίλαθαο 2.1: Γεδνκέλα ηνπ πξνβιήκαηνο. 

Γεσκεηξηθά ραξαθηεξηζηηθά 

πιάθαο 

(mm) 

Ύςνο (height) 100 

Πιάηνο (width) 200 

Πάρνο (thickness) 20 

Αθηίλα νπήο (radius) 20 

Ηδηόηεηεο πιηθνύ: 

Μέηξν ειαζηηθόηεηαο Ε 207*10
3
 Ν/mm

2
 

Λόγνο Poisson λ  0.3 

Φόξηηζε 

Δθειθπζηηθή νξζή ηάζε  1 Ν/mm
2
 

 

 

Σν θνκκάηη πνπ ζα κειεηεζεί έρεη ζπκκεηξηθή γεσκεηξία θαη θόξηηζε. 
Οπόηε κπνξεί λα ρσξηζηεί ζε 4 ίζα θνκκάηηα θαη λα κειεηεζεί ην έλα από απηά: 

ην απνηέιεζκα πνπ ζα βξεζεί ζα είλαη αλάινγν κε ην απνηέιεζκα πνπ ζα 
βξηζθόηαλ αλ γηλόηαλ κειέηε ζε νιόθιεξν. Λόγσ ησλ ίζσλ εθειθπζηηθώλ 

ηάζεσλ πνπ δέρεηαη ε πιάθα ζηηο πιεπξέο όπνπ έρεη γίλεη ηνκή, έρνπλ κπεη 
αληίζηνηρεο θπιίζεηο. ΢ηελ θάζεηε πιεπξά έρεη απνθιεηζηεί ε κεηαηόπηζε ζηνλ 

άμνλα xx’ θαη ζηελ νξηδόληηα πιεπξά ε κεηαηόπηζε ζηνλ άμνλα yy’. 

 

2.1.1 Μνληέιν πεπεξαζκέλωλ ζηνηρείωλ 

 

Σν πξόβιεκα επηιύεηαη κε ηε κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ 
(ΜΠ΢) κε ηε ρξήζε ηνπ εκπνξηθνύ παθέηνπ ANSYS 9.0. Λόγσ ηνπ κηθξνύ 

πάρνπο ηεο πιάθαο ζε ζρέζε κε ηηο άιιεο δηαζηάζεηο ηεο, γηα ηε κνληεινπνίεζε 
ζεσξείηε όηη θαηά ηελ θαηαπόλεζε ηεο αλαπηύζζεηαη επίπεδε θαηάζηαζε 

ηάζεσλ (plane stress). Γηα ην ιόγν απηό, γηα ηελ θαηαζθεπή ηνπ κνληέινπ ησλ 
πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηνύληαη επηθαλεηαθά δηδ ηάζηαηα ζηνηρεία 
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(PLANE2), δηαθξηηνπνηώληαο ηε κέζε επηθάλεηα ηεο πιάθαο. Tν πάρνο ηεο 

ιακβάλεηαη ππόςε σο ηδηόηεηα ηνπ ζηνηρείνπ (ζην ANSYS κέζσ ηνπ νξηζκνύ 
ελόο real constant). Σν ζηνηρείν PLANE2 θαζνξίδεηαη από 6 θόκβνπο, κε δύν 
βαζκνύο ειεπζεξίαο ζε θάζε θόκβν (ηηο κεηαηνπίζεηο ζηηο θνκβηθέο 

θαηεπζύλζεηο x θαη y). ΢ην ΢ρήκα 2.2 πνπ αθνινπζεί θαίλεηαη ε γεσκεηξία, ε 
ηνπνζεζία ησλ θόκβσλ, θαη ην ζύζηεκα ζπληεηαγκέλσλ γηα ην ζηνηρείν 

PLANE2.  

 

΢ρήκα 2.2: Απεηθόληζε ηνπ ζηνηρείνπ PLANE2. 

 

Με ζθνπό ηελ πηζηνπνίεζε ηεο ζύγθιηζεο ησλ απνηειεζκάησλ ε πιάθα 
δηαθξηηνπνηήζεθε κε δπν δηαθνξεηηθά κεγέζε πιέγκαηνο. Σν πιέγκα 1 (ην πην 

αξαηό), ΢ρήκα 2.3.α, απνηειείηαη από 46 PLANE2 ζηνηρεία (elements) θαη 113 
θόκβνπο (nodes) ελώ ην πιέγκα 2 (ην πην ππθλό), ΢ρήκα 2.3.β, από 228 
PLΑNE2 ζηνηρεία (elements) θαη 503 θόκβνπο (nodes).  

 

  

(α) (β) 

΢ρήκα 2.3: (α)Πιέγκα 1 (46 ζηνηρεία) θαη (β) πιέγκα 2 (228 ζηνηρεία). 
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2.1.2 Απνηειέζκαηα 

 

΢ηα ΢ρήκαηα 2.4α, 2.4β, 2.5α θαη 2.5β  παξνπζηάδεηαη ε παξακνξθσκέλε 
πιάθα θαη ε θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα, όπσο πξνθύπηεη από ηελ 

επίιπζε ηνπ πξνβιήκαηνο κε ηε ρξήζε ησλ δύν πιεγκάησλ.  

  

(α) (β) 

΢ρήκα 2.4: Παξακνξθσκέλε πιάθα: (α) Πιέγκα 1 (46 ζηνηρεία) θαη (β) πιέγκα 2 (228 
ζηνηρεία) 

 

  

(α) (β) 

΢ρήκα 2.5: Καηαλνκή ησλ κεηαηνπίζεσλ: (α) Πιέγκα 1 (46 ζηνηρεία) θαη (β) πιέγκα 2 (228 
ζηνηρεία) 

 

΢ην ΢ρήκα 2.6α θαη 2.6β παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο 
ηάζεο όπσο απηή πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises γηα ηα 

πιέγκαηα 1 θαη 2, αληίζηνηρα. 
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(α) (β) 

΢ρήκα 2.6: Καηαλνκή ησλ κεηαηνπίζεσλ: (α) Πιέγκα 1 (46 ζηνηρεία) θαη (β) πιέγκα 2 (228 

ζηνηρεία) 

 

΢ην ζρήκα 2.6 παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο ηάζεο όπσο 

απηή πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises γηα ηα πιέγκαηα 1 θαη 2 
αληίζηνηρα. H ζύγθιηζε ησλ απνηειεζκάησλ είλαη θαλεξή (κέγηζηεο ηζνδύλακεο 

ηάζεηο 4 θαη 4,3 ζην πιέγκα 1 θαη 2 αληίζηνηρα).  

 

2.2 ΤΠΟΛΟΓΗ΢ΜΟ΢ ΣΧΝ ΣΑ΢ΔΧΝ ΚΑΗ ΣΧΝ ΠΑΡΑΜΟΡΦΧ΢ΔΧΝ ΣΜΖΜΑΣΟ΢ 

ΣΖ΢ ΕΧΝΖ΢ Α΢ΦΑΛΔΗΑ΢  

 

2.2.1 Πεξηγξαθή ηνπ πξνβιήκαηνο 

 

Σν ηκήκα ηεο δώλεο αζθαιείαο είλαη κεηαιιηθό, έρεη κήθνο  πεξίπνπ 15  
mm θαη έρεη 2 mm πάρνο. Με κέηξν ειαζηηθόηεηαο Ε=30*10

3
 Ν/mm

2
 θαη ιόγν 

Poisson λ=0.3. ΢ηνλ Πίλαθα 2.2 θαίλνληαη αλαιπηηθά όια ηα δεδνκέλα ηνπ 
πξνβιήκαηνο. 



 

 

30 

 

΢ρήκα 2.7: Σκήκα δώλεο αζθαιείαο 

 

 

Πίλαθαο 2.2: Γεδνκέλα ηνπ πξνβιήκαηνο 

Γεσκεηξηθά ραξαθηεξηζηηθά 

πιάθαο 

(mm) 

Ύςνο (height) 15 

Πιάηνο (width) 15 

Πάρνο (thickness) 2 

Ηδηόηεηεο πιηθνύ 

Μέηξν ειαζηηθόηεηαο Ε 30*10
3
 Ν/mm

2
 

Λόγνο Poisson λ  0.3 

Φόξηηζε 

Δθειθπζηηθή πιάγηα ηάζε  1.4 Ν/mm
2
 

 

Σν θνκκάηη πνπ ζα κειεηεζεί έρεη ζπκκεηξηθή γεσκεηξία θαη θόξηηζε. 

Οπόηε κπνξεί λα ρσξηζηεί ζε δύν ίζα θνκκάηηα θαη λα κειεηήζνπκε ην έλα από 
απηά: ην απνηέιεζκα πνπ ζα βγεη ζα είλαη αλάινγν κε ην απνηέιεζκα πνπ ζα 

βξηζθόηαλ αλ είρε κειεηεζεί νιόθιεξν. 
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2.2.2 Μνληέιν πεπεξαζκέλωλ ζηνηρείωλ 

 

Σν πξόβιεκα επηιύεηαη κε ηε κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ 
(ΜΠ΢) κε ηε ρξήζε ηνπ εκπνξηθνύ παθέηνπ ANSYS 9.0.  Λόγσ ηνπ κηθξνύ 

πάρνπο ηεο πιάθαο ζε ζρέζε κε ηηο άιιεο δηαζηάζεηο ηεο, γηα ηε κνληεινπνίεζε 
ζεσξνύκε όηη θαηά ηελ θαηαπόλεζε ηεο αλαπηύζζεηαη επίπεδε θαηάζηαζε 

ηάζεσλ (plane stress). Γηα ην ιόγν απηό, γηα ηελ θαηαζθεπή ηνπ κνληέινπ ησλ 
πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηνύληαη επηθαλεηαθά δηδηάζηαηα ζηνηρεία 

(PLANE183), δηαθξηηνπνηώληαο ηε κέζε επηθάλεηα ηεο πιάθαο. Σν πάρνο ηεο 
ιακβάλεηαη ππόςε σο ηδηόηεηα ηνπ ζηνηρείνπ (ζην ANSYS κέζσ ηνπ νξηζκνύ 

ελόο real constant). Σν ζηνηρείν PLANE183 θαζνξίδεηαη από 8 θόκβνπο, κε δύν 
βαζκνύο ειεπζεξίαο ζε θάζε θόκβν (ηηο κεηαηνπίζεηο ζηηο θνκβηθέο 

θαηεπζύλζεηο x θαη y). ΢ην ΢ρήκα 2.8 πνπ αθνινπζεί θαίλεηαη ε γεσκεηξία, ε 
ηνπνζεζία ησλ θόκβσλ, θαη ην ζύζηεκα ζπληεηαγκέλσλ γηα ην ζηνηρείν 
PLANE183.  

 

΢ρήκα 2.8: Απεηθόληζε ηνπ ζηνηρείνπ PLANE183. 

 

 
Με ζθνπό ηελ πηζηνπνίεζε ηεο ζύγθιηζεο ησλ απνηειεζκάησλ ην 

ζηήξηγκα δηαθξηηνπνηήζεθε κε δπν δηαθνξεηηθά κεγέζε πιέγκαηνο. Σν πιέγκα 1 
(ην πην αξαηό), ΢ρήκα 2.9α, απνηειείηαη από 3599 ζηνηρεία θαη 1182 θόκβνπο 

ελώ ην πιέγκα 2 (ην πην ππθλό), ζρήκα 2.9β, από 1434 ζηνηρεία θαη 4511 
θόκβνπο. 
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(α) (β) 

΢ρήκα 2.9: (α) Πιέγκα 1 (359 ζηνηρεία) θαη (β) πιέγκα 2 (1434 ζηνηρεία). 

  

Γηα λα πξνζνκνησζεί ν ηξόπνο ζηήξημεο ηνπ εμαξηήκαηνο, ζηελ αξηζηεξή 

πιεπξά κπήθε κηα θύιηζε πνπ δελ επηηξέπεη ηελ θίλεζε ηεο πιεπξάο απηήο θαηά 
ηνλ άμνλα xx’. ΢ηηο θάησ πιεπξέο κπήθε άιιε κηα θύιηζε κε επηηξέπνληαο ηελ 

θίλεζε θαηά ηνλ άμνλα yy’. Γηα λα πξνζνκνησζεί ν ηξόπνο θόξηηζεο, 
εθαξκόζηεθε κηα πίεζε ζηε δεμηά από ηηο εζσηεξηθέο γξακκέο, όπσο θαίλεηαη 

ζην ΢ρήκα 2.10.  

 

 

΢ρήκα 2.10: Απεηθόληζε ζηεξίμεσλ (ηξηγσλάθηα) θαη θόξηηζεο (θόθθηλε γξακκή) 
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2.2.3 Απνηειέζκαηα 

 

΢ηα ΢ρήκαηα 2.11 θαη 2.12, παξνπζηάδεηαη ε παξακνξθσκέλε πιάθα θαη 
ε θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα. Παξαηεξώληαο ην ζρήκα ηεο 

παξακνξθσκέλεο πιάθαο, δηαπηζηώλεη θαλείο όηη ιόγσ ηεο νπήο πνπ ππάξρεη 
ζην κέζν ηεο πιάθαο έρνπκε κηα κέγηζηε εγθάξζηα κεηαηόπηζε, θαη ε νπή 

αλνίγεη. 

  

(α) (β) 

΢ρήκα 2.11: Παξακνξθσκέλν ζηήξηγκα : (α) Πιέγκα 1 (359 ζηνηρεία) θαη (β) πιέγκα 2 

(1434 ζηνηρεία). 

 

  

(α) (β) 

΢ρήκα 2.12: Καηαλνκή ησλ κεηαηνπίζεσλ: (α) Πιέγκα 1 (359 ζηνηρεία) θαη (β) πιέγκα 2 

(1434 ζηνηρεία). 
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΢ην ΢ρήκα 2.13, παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο ηάζεο όπσο 

απηή πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises γηα ηα πιέγκαηα 1 θαη 2, 
αληίζηνηρα. 

 

  

(α) (β) 

΢ρήκα 2.13: Καηαλνκή ησλ ηάζεσλ: (α) Πιέγκα 1 (9969 ζηνηρεία) θαη (β) πιέγκα 2 (17074 

ζηνηρεία). 

 
΢πγθξίλνληαο ηα απνηειέζκαηα από ηα δύν πιέγκαηα πξνθύπηεη όηη ζε 

επίπεδν ηάζεσλ ε ζύγθιηζε είλαη θαλεξή (κέγηζηεο ηζνδύλακεο ηάζεηο 137.798 
θαη 139.836 ζην πιέγκα 1 θαη 2 αληίζηνηρα). 
 

 
  

2.3 ΔΤΡΔ΢Ζ ΣΟΤ ΢ΤΝΣΔΛΔ΢ΣΖ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ ΠΛΑΚΑ΢ ΜΔ ΡΧΓΜΖ ΢ΣΖΝ 

ΜΔ΢Ζ  

 

2.3.1 Πεξηγξαθή ηνπ πξνβιήκαηνο 

 

Έρνπκε κηα ηεηξάγσλε πιάθα κε κηα ξσγκή ζην θέληξν όπσο θαίλεηαη 
ζην ΢ρήκα 2.14. Ζ πιάθα είλαη θηηαγκέλε από ράιπβα κε κέηξν ειαζηηθόηεηαο 

Ε=200*10
3
 Ν/mm

2
, ιόγν Poisson λ=0.3 θαη ζ=100 Ν/mm

2
. Οη δηαζηάζεηο ηεο 

πιάθαο είλαη : b=0.2 m, a=0.02 m.  
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΢ρήκα 2.14: Πιάθα κε ξσγκή ζηελ κέζε 

 

Θεσξεηηθόο ζπληειεζηήο έληαζεο ηάζεο (Walter D. Pilkey, Formulas for Stress, 
Strain, and Structural Matrices, second edition, John Wiley & Sons, Inc. 2005): 

2 3

1 0.256 1.152 12.2

IK Y

ό

a a a
Y

b b b

 





   
       

   

 

2 3

2 3

2

0.02 0.02 0.02
1 0.256 1.152 12.2

0.2 0.2 0.2

1 0.256 0.1 1.152 0.1 12.2 0.1

1.02628

1.02628 100 3.14 0.02

25,718 / mm

I

I

I

Y

Y

Y

K Y

K

K mm

 

   
       

   

       



 

    

  

 

 

΢ηελ πεξίπησζε απηή, επεηδή ην ζρήκα επίζεο είλαη ζπκκεηξηθό θαη νη 
δπλάκεηο θαη νη πηέζεηο πνπ αζθνύληαη είλαη ζπκκεηξηθέο, ζα κειεηεζεί ην ¼ ηεο 

πιάθαο. 
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2.3.2 Απνηειέζκαηα 

 

΢ηα ζρήκαηα 2.15 θαη 2.16 παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη 
ε θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα όπσο πξνθύπηνπλ από ηελ επίιπζε 

ηνπ πξνβιήκαηνο.  

 

΢ρήκα 2.15: Παξακνξθσκέλε πιάθα. 

 

΢ρήκα 2.16: Καηαλνκή ησλ κεηαηνπίζεσλ. 
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΢ην ΢ρήκα 2.17 παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο ηάζεο όπσο απηή 

πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises. 

 

 

΢ρήκα 2.17: Καηαλνκή ησλ ηάζεσλ. 

Παξαθάησ θαίλεηαη ε επί ηνηο εθαηό απόθιηζε ηεο ζεσξεηηθήο ηηκήο κε απηήλ 
πνπ πξνέθπςε κε ην AΝSYS: 

 

25,718 26,533
100% 100% 3%

25,718

ό Ansys

I I

ό

I

K K
e

K









 
      

 

2.3.3 Μνληέιν πεπεξαζκέλωλ ζηνηρείωλ 

 

Σν πξόβιεκα επηιύεηαη κε ηε κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ 

(ΜΠ΢) κε ηε ρξήζε ηνπ εκπνξηθνύ παθέηνπ ANSYS 9.0. Γηα ηελ θαηαζθεπή 
ηνπ κνληέινπ ησλ πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηνύληαη αλώηεξεο ηάμεο 

δηδηάζηαηα ζηνηρεία (PLANE 82), ηα νπνία θαζνξίδνληαη από δύν βαζκνύο 
ειεπζεξίαο ζε θάζε θόκβν (κεηαηνπίζεηο ζηηο θνκβηθέο θαηεπζύλζεηο Υ θαη Τ). 

΢ην ΢ρήκα 2.18 θαίλεηαη ε γεσκεηξία, ε ηνπνζεζία ησλ θόκβσλ θαη ην ζύζηεκα 
ζπληεηαγκέλσλ γηα ην ζηνηρείν PLANE 82. 
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΢ρήκα 2.18: Απεηθόληζε ηνπ ζηνηρείνπ PLANE 82. 

 

΢ηελ πεξηνρή γύξσ από ην άθξν ηεο ξσγκήο ρξεζηκνπνηήζεθαλ εηδηθνύ 
ηύπνπ ζηνηρεία όπνπ νη κεζαίνη θόκβνη δελ είλαη πιένλ ζην θέληξν αιιά ζην ¼ 

ηεο πιεπξάο (quarter point element) (΢ρήκα 2.19). H ηδηαηηεξόηεηα απηώλ ησλ 

ζηνηρείσλ είλαη όηη έρνπλ ηελ δπλαηόηεηα λα πξνζνκνηώζνπλ ηελ r  θαη ηελ 
1

r
, ζπκπεξηθνξά πνπ παξνπζηάδνπλ νη κεηαηνπίζεηο θαη νη ηάζεηο αληίζηνηρα, 

ζην άθξν ηεο ξσγκήο. 

 

΢ρήκα 2.19: ΢ηνηρεία κε ηνπο θόκβνπο ζην ¼ ηεο πιεπξάο (Quarter point elements). 
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Παξαθάησ ην πξόβιεκα απηό έρεη επηιπζεί θαη κε δεύηεξν ηξόπν, 

ζρεδηάδνληαο νιόθιεξε ηελ πιάθα γηα λα βξεζεί ν ζπληειεζηήο έληαζεο ηάζεο 
θαη λα ζπγθξηζεί κε ηνλ ζεσξεηηθό. 

 

2.3.4 Απνηειέζκαηα 

 
΢ηα ΢ρήκαηα 2.20 θαη 2.21 παξνπζηάδνληαη παξακνξθσκέλε πιάθα θαη ε 

θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα όπσο πξνθύπηνπλ από ηελ επίιπζε ηνπ 
πξνβιήκαηνο.  

 

 

΢ρήκα 2.20: Παξακνξθσκέλε πιάθα. 
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΢ρήκα 2.21: Καηαλνκή ησλ κεηαηνπίζεσλ. 

 

΢ην ΢ρήκα 2.22, παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο ηάζεο όπσο απηή 

πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises. 

 

 

΢ρήκα 2.22: Καηαλνκή ησλ ηάζεσλ. 
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Παξαθάησ θαίλεηαη ε επί ηνηο εθαηό απόθιηζε ηεο ζεσξεηηθήο ηηκήο από απηήλ 

πνπ ππνινγίζηεθε κε ην AΝSYS: 

25,718 26,197
100% 100% 2%

25,718

ό Ansys

I I

ό

I

K K
e

K









 
      

 

2.3.5 ΢πκπέξαζκα 

 

Όπσο βιέπνπκε ε δηαθνξά ησλ πεηξακαηηθώλ ηηκώλ ησλ δύν ιύζεσλ κε 
ηε ζεσξεηηθή ηηκή δελ έρνπλ κεγάιε απόθιηζε. 

Δπίζεο, νη πεηξακαηηθέο ηηκέο δελ έρνπλ ζεκαληηθή απόθιηζε κεηαμύ 

ηνπο, άξα ζε αλάινγε πεξίπησζε αξθεί λα ππνινγηζηεί ν ζπληειεζηήο έληαζεο 
ηάζεο κειεηώληαο ην ¼ ηνπ θνκκαηηνύ. 

 

2.4 ΔΤΡΔ΢Ζ ΣΟΤ ΢ΤΝΣΔΛΔ΢ΣΖ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ ΠΛΑΚΑ΢ ΜΔ ΡΧΓΜΖ ΢ΣΖΝ 

ΑΚΡΖ  

 

2.4.1 Πεξηγξαθή ηνπ πξνβιήκαηνο 

 

Έρνπκε κηα ηεηξάγσλε πιάθα (΢ρήκα 2.23) κε κηα ζρηζκή ζηελ άθξε 

όπσο απεηθνλίδεηαη παξαθάησ. Ζ πιάθα είλαη θηηαγκέλε από ράιπβα κε κέηξν 
ειαζηηθόηεηαο Ε=200*10

3
 Ν/mm

2
, ιόγν Poisson λ=0.3 θαη ζ=100 Ν/mm

2
. Οη 

δηαζηάζεηο ηεο πιάθαο είλαη : W=0.2 m, L=0.2 m, a=0.02 m.  

 

΢ρήκα 2.23: Πιάθα κε ξσγκή ζηελ άθξε. 
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2.4.2 Μνληέιν πεπεξαζκέλωλ ζηνηρείωλ 

 

Σν πξόβιεκα επηιύεηαη κε ηε κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ 
(ΜΠ΢) κε ηε ρξήζε ηνπ εκπνξηθνύ παθέηνπ ANSYS 9.0. Γηα ηελ θαηαζθεπή 

ηνπ κνληέινπ ησλ πεπεξαζκέλσλ ζηνηρείσλ ρξεζηκνπνηνύληαη αλώηεξεο ηάμεο 
δηδηάζηαηα ζηνηρεία (PLANE 82), ηα νπνία θαζνξίδνληαη από δύν βαζκνύο 

ειεπζεξίαο ζε θάζε θόκβν (κεηαηνπίζεηο ζηηο θνκβηθέο θαηεπζύλζεηο Υ θαη Τ). 
΢ην ΢ρήκα 2.24 πνπ αθνινπζεί θαίλεηαη ε γεσκεηξία, ε ηνπνζεζία ησλ θόκβσλ 

θαη ην ζύζηεκα ζπληεηαγκέλσλ γηα ην ζηνηρείν PLANE 82. 

 

 

 

΢ρήκα 2.24: Απεηθόληζε ηνπ ζηνηρείνπ PLANE 82. 

 

 Γηα ηα ζηνηρεία ηεο πεξηνρήο γύξσ από ηελ ξσγκή ζα πξάμνπκε όπσο θαη 
ζηελ Παξάγξαθν 2.3. 
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2.4.3 Απνηειέζκαηα 

 

΢ηα ΢ρήκαηα 2.25 θαη 2.26 παξνπζηάδνληαη ε παξακνξθσκέλε πιάθα θαη 
ε θαηαλνκή ησλ κεηαηνπίζεσλ, αληίζηνηρα όπσο πξνθύπηνπλ από ηελ επίιπζε 

ηνπ πξνβιήκαηνο.  

 

 

΢ρήκα 2.25: Παξακνξθσκέλε πιάθα. 

 

 

΢ρήκα 2.26: Καηαλνκή ησλ κεηαηνπίζεσλ. 



 

 

44 

΢ην ΢ρήκα 2.27, παξνπζηάδεηαη ε θαηαλνκή ηεο ηζνδύλακεο ηάζεο όπσο απηή 

πξνθύπηεη από ην θξηηήξην αζηνρίαο von Mises. 

 

 

΢ρήκα 2.27: Καηαλνκή ησλ ηάζεσλ. 

 

Ζ ιύζε ηνπ ANSYS (KI = 30.752 Ν/mm
2
) είλαη απνδεθηή γηαηί είλαη 

πνιύ θνληά ζηε ζεσξεηηθή ηηκή (KI = 30.072 Ν/mm
2
) πνπ πξνέθπςε κε ηνλ 

εμήο ηξόπν:  

 

Σν ΚΗ ππνινγίδεηαη από ηνλ ηύπν: 

IK     

 

΢ην ζπγθεθξηκέλν παξάδεηγκα, πνπ ε ξσγκή είλαη ζηελ άθξε ηεο πιάθαο 

ν ιόγνο L/W=1.Δπεηδή γηα απηή ηελ ηηκή ηνπ L/W, δελ ππάξρεη έηνηκνο ηύπνο 
γηα ηνλ ππνινγηζκό ηνπ Τ, ζα ην ππνινγηζηεί κε ηελ βνήζεηα ηνπ παξαθάησ 

δηαγξάκκαηνο. Δπίζεο, ν ιόγνο α/W=0.02/0.2=0.1. 
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΢ρήκα 2.28: Γηάγξακκα ππνινγηζκνύ Y. (Σν δηάγξακκα έρεη παξζεί από David Broek, The 

practical use of Fracture Mechanics Copyright © 1988 Kluwer Academic Publishers, 

Netherlands). 

 

Άξα κε βάζε ηα παξαπάλσ πξνθύπηεη όηη Τ=1.2. Έηζη, ηειηθά έρνπκε όηη ην 
ζεσξεηηθό ΚΗ είλαη: 

 

21,2 100 3,14 0,02 30,072 / mmIK           

 

 Ζ απόθιηζε % είλαη: 

 

.

.

30,072 30,752
100% 100% 2.26%

30,072

Ansys

I I

I

K K
e

K





 
    
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ΚΔΦΑΛΑΗΟ 3 

 

ΤΠΟΛΟΓΗ΢ΜΟ΢ ΢ΤΝΣΔΛΔ΢ΣΧΝ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ ΢Δ 

ΡΖΓΜΑΣΧΜΔΝΟ ΓΡΑΝΑΕΗ 

 

3.1 ΢ΚΟΠΟ΢ TOY ΤΠΟΛΟΓΗ΢ΜΟΤ 

 

 Ο ππνινγηζκόο ηνπ ζπληειεζηή έληαζεο ηάζεο ζε ξεγκαησκέλν γξαλάδη 

ζα πξαγκαηνπνηεζεί κε ηε ρξήζε ηνπ πξνγξάκκαηνο ANSYS 9.0. Έρνπκε έλα 
γξαλάδη ηνπ νπνίνπ ηα ραξαθηεξηζηηθά θαίλνληαη ζηνλ Πίλαθα 4.2. Γηα λα 

κπνξέζεη λα ζρεδηαζηεί ε ξσγκή ζην ζσζηό ζεκείν ηνπ δνληηνύ ζα πξέπεη 
πξώηα λα κειεηεζεί ην γξαλάδη ρσξίο ξσγκή θαη γηα λα είλαη πην αθξηβείο νη 

ππνινγηζκνί ζα γίλεη ε κειέηε κε δύν δηαθξηηνπνηήζεηο. Δθόζνλ 
πξαγκαηνπνηεζεί ε κειέηε ηνπ γξαλαδηνύ ρσξίο ηε ξσγκή, ζην ζεκείν πνπ 

εκθαλίδνληαη νη κέγηζηεο ηάζεηο ζα δεκηνπξγεζεί κηα ξσγκή. Έπεηηα, ζην 
γξαλάδη κε ηελ ξσγκή ζα γίλνπλ δύν δηαθξηηνπνηήζεηο γηα λα κπνξέζνπκε λα 

δηαπηζηώζνπκε ηελ αθξίβεηα ησλ ππνινγηζκώλ ηνπ πξνγξάκκαηνο θαη ζε απηό 
ην ζηάδην. Έπεηηα, ζα γίλεη ν ππνινγηζκόο ηνπ ζπληειεζηή έληαζεο ηάζεο. ΢ηηο 

επόκελεο παξαγξάθνπο θαίλνληαη αλαιπηηθά όια ηα βήκαηα. 

 

3.2 ΜΖΥΑΝΗΚΔ΢ ΗΓΗΟΣΖΣΔ΢ ΣΧΝ ΤΛΗΚΧΝ 

 

Ζ ζηαηηθή αλάιπζε ησλ γξαλαδηώλ πνπ αθνινπζεί έγηλε ζύκθσλα κε ηε 
κέζνδν ησλ πεπεξαζκέλσλ ζηνηρείσλ θαη ηε ρξήζε ηνπ πξνγξάκκαηνο ANSYS 
9.0, ελώ πηνζεηήζεθαλ νη ηηκέο ηνπ Πίλαθα 3.1 γηα ηηο ηδηόηεηεο ησλ πιηθώλ. 
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Πίλαθαο 3.1: Αληηπξνζσπεπηηθέο ηηκέο ησλ κεραληθώλ ηδηνηήησλ ηνπ πιηθνύ. 

 

Τιηθό 

 

Μέηξν 
Διαζηηθόηεηαο 

Δ(Ν/mm
2
) 

 

Λόγνο 

Poisson 

v 

 

Όξην 

ζξαύζεο 

Su 
(N/mm

2
) 

 

Όξην 

δηαξξνήο 

Sy 
(N/mm

2
) 

Κξίζηκνο 
ζπληειεζηήο 

έληαζεο 

ηάζεο ΚΗc 

Ν/mm
2

mm  

Κξάκα 

αινπκηλίνπ 
(4340 

ζθιεξπκέλνο 
ζηνπο 260 

0
C) 

2.1x10
5 

0.3 930 785 1581 

 

3.3 ΢ΥΔΓΗΑ΢ΜΟ΢ ΚΑΗ ΠΔΡΗΓΡΑΦΖ ΓΡΑΝΑΕΗΟΤ 

 

3.3.1 Γξαλάδη ρωξίο ξωγκή 

 

΢ην αξρηθό γξαλάδη δελ ππάξρεη θάπνηα ξσγκή θαη γηα απηό ν ζρεδηαζκόο 
ηνπ θαζίζηαηαη πην εύθνινο από ην γξαλάδη κε ηε ξσγκή. Ο ζρεδηαζκόο ζα 

πξαγκαηνπνηεζεί από ην ζρεδηαζηηθό κέξνο ηνπ πξνγξάκκαηνο ANSYS, κε 
θάπνηεο βαζηθέο εληνιέο. Αξρηθά νξίζακε ηα ζεκεία από ηηο απαηηνύκελεο 

ζπληεηαγκέλεο ζύκθσλα κε ηα ραξαθηεξηζηηθά ζηνηρεία ηνπ γξαλαδηνύ πνπ 
απνηππώλνληαη ζηνλ Πίλαθα 3.1 θαη ελώλνληάο ηα δεκηνπξγήζακε ηηο γξακκέο. 

΢ηε ζπλέρεηα ελώζακε ηηο γξακκέο, νξίδνληαο έηζη επηθάλεηεο (΢ρήκα 3.1).  

 

Πίλαθαο 3.2: Υαξαθηεξηζηηθά ζηνηρεία γξαλαδηνύ. 

α/α Ολνκαζία Σηκή 

1 Module (m) 8 

2 Αξηζκόο δνληηώλ (Z 

ή N) 

18 

3 Ρνπή (Σ) 250*10
3
 Ν*mm 
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΢ρήκα 3.1: Γξαλάδη ρσξίο ξσγκή. 

 

4.3.2 Πξνζνκνίωζε γξαλαδηνύ - Γηαδηθαζία αλάιπζεο 

 

Σν γξαλάδη ρσξίζηεθε ζε θαηάιιεια γηα ην πξόβιεκα πεπεξαζκέλα 
ζηνηρεία, ελώ παξάιιεια πξνζνκνηώζεθε ν ηξόπνο ζηήξημεο θαη ηα θνξηία πνπ 

θαηαπνλνύλ ην γξαλάδη, ώζηε λα θαηαζηεί δπλαηή ε ζηαηηθή ηνπο αλάιπζε ζην 
πξόγξακκα Ζ/Τ πνπ επηιέμακε γηα ηελ παξνύζα κειέηε.  

 

4.3.3 Δπηινγή πεπεξαζκέλωλ ζηνηρείωλ 

 

Γηα ηελ δηαθξηηνπνίεζε ησλ γξαλαδηώλ, επηιέμακε ην ζηνηρείν:  

PLANE82→  8node 82 

Πεξηγξαθή ηνπ ζηνηρείνπ PLANE82: 

Σν ζηνηρείν PLANE82 είλαη έλα πςειώλ πξνδηαγξαθώλ δηδηάζηαην 
ζηνηρείν 8 θόκβσλ. Σα ζηνηρεία απηά θαζνξίδνληαη από δύν βαζκνύο ειεπζεξίαο 

ζε θάζε θόκβν (κεηαηνπίζεηο ζηηο θνκβηθέο θαηεπζύλζεηο Υ θαη Τ). ΢ην ΢ρήκα 
3.4 θαίλεηαη ε γεσκεηξία, ε ηνπνζεζία ησλ θόκβσλ θαη ην ζύζηεκα 

ζπληεηαγκέλσλ γηα ην ζηνηρείν PLANE 82. Σν ζηνηρείν παξνπζηάδεη ηα εμήο 
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ραξαθηεξηζηηθά: πιαζηηθόηεηα, εξππζκό, δπζθακςία, δηόγθσζε, αθακςία 

πίεζεο, κεγάιε παξακόξθσζε θαη κεγάιεο δπλαηόηεηεο πίεζεο.  

 

4.3.4 Γηαθξηηνπνίεζε γξαλαδηνύ  

 

 Ζ δηαθξηηνπνίεζε ηνπ γξαλαδηνύ ζε πεπεξαζκέλα ζηνηρεία έγηλε 
νξίδνληαο θαη’ αξρήλ ηνλ ηύπν ησλ ζηνηρείσλ (plane82), ηηο ηδηόηεηεο ησλ 

πιηθώλ ηνπ Πίλαθα 3.1 θαη ην κέγεζνο πιέγκαηνο. Σν γξαλάδη ρσξίο ξσγκή 
απνηειείηαη από 9184 ζηνηρεία θαη 19812 θόκβνπο (΢ρήκα 3.2). 

 

 

΢ρήκα 3.2: Γηαθξηηνπνίεζε γξαλαδηνύ ρσξίο ξσγκή. 

 

Γηα κεγαιύηεξε αθξίβεηα δηαθξηηνπνίεζακε ην γξαλάδη κε κηθξόηεξν 
κέγεζνο πιέγκαηνο (ππθλόηεξν πιέγκα). Έηζη ην γξαλάδη ρσξίο ξσγκή κε 
ππθλόηεξν πιέγκα απνηειείηαη από 30808 ζηνηρεία θαη 64292 θόκβνπο (΢ρήκα 

3.3).  
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΢ρήκα 3.3: Γηαθξηηνπνίεζε γξαλαδηνύ ρσξίο ξσγκή (ππθλόηεξν πιέγκα). 
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4.3.5 Πξνζνκνίωζε ηεο ζηήξημεο θαη ηωλ θνξηίωλ 

 

Πξνζνκνηώζακε ηνλ ηξόπν ζηήξημεο ηνπ γξαλαδηνύ επί ηνπ άμνλα κε κηα 

πάθησζε, ώζηε λα κελ επηηξέπεηαη αμνληθή κεηαηόπηζε (Uy) θαη αθηηληθή 
κεηαηόπηζε (Ux)  

Ζ πίεζε πνπ αζθείηαη ζην θάζε δόληη ηνπ δηθνύ καο γξαλαδηνύ ην νπνίν 
είλαη ην θηλνύκελν, νθείιεηαη ζηελ δύλακε πνπ αζθεί ην δόληη ηνπ θηλεηήξηνπ 

γξαλαδηνύ (θάζε θνξά έξρεηαη ζε επαθή έλα δεύγνο δνληηώλ) ζην θηλνύκελν 
γξαλάδη ζην ζεκείν επαθήο ηνπο.  

Γηα λα κπνξέζνπκε λα ππνινγίζνπκε αξηζκεηηθά ηελ πίεζε πνπ αζθείηαη 

ζην ζεκείν επαθήο, ην νπνίν  ζύκθσλα κε ηελ ζεσξία επαθώλ ηνπ Hertz γίλεηαη 
επηθάλεηα (΢ρήκα 3.4), ζα πξέπεη λα ππνινγίζνπκε ην πιάηνο απηήο ηεο 

επηθάλεηα. Σν θηλνύκελν θαη ην θηλεηήξην γξαλάδη έρνπλ ηα ίδηα ηερληθά θαη 
ζρεδηαζηηθά ραξαθηεξηζηηθά (Πίλαθαο 3.2). 

 

΢ρήκα 3.4: Σάζε (Hertz) επαθήο ζH θαη ηάζε θάκςεο ζb ζην δόληη πνπ δέρεηαη ην θνξηίν. 
(Σν ζρήκα έρεη παξζεί από Boris M. Klebanov, David M. Barlam, Machine elements Life and 
Design, CRC Press Taylor & Francis Group, New York 2008). 

0,418 n

e

F E

L



 

                    

(3.1) 

 

Όπνπ:  

Δ = κέηξν ειαζηηθόηεηαο 

L = κήθνο γξακκήο επαθήο 
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ξe = ηζνδύλακε αθηίλα θακππιόηεηαο (mm), πνπ είλαη: 

1 2

1 2

e

 


 


    
 (3.2) 

 

Σν πιάηνο ηεο πεξηνρήο επαθήο δίλεηαη από 

3.04 n e
c

F
b

LE




  
 (3.3) 

 

Ξεθηλάκε ππνινγίδνληαο ηελ δηάκεηξν βάζεο ηνπ γξαλαδηνύ 

0

1 1 cos20 8 18 0.9397 135.31bd mN mm      

 

Ζ δύλακε επαθήο δνληηνύ είλαη 

31

3

1

2 2 250
3.7 10

135.31 10
n

b

T
F N

d 


   

  

 

Ζ κέγηζηε πίεζε επαθώλ δελ είλαη ζηαζεξή, επεηδή νη αθηίλεο ηεο 
θπξηόηεηαο ξ θαη ηνπ ζπλνιηθνύ κήθνπο ησλ γξακκώλ L επαθώλ πνηθίιινπλ 

θαζώο ηα γξαλάδηα πεξηζηξέθνληαη. ΢πλήζσο, ε κέγηζηε πίεζε επηθάλεηαο 
θαζνξίδεηαη όηαλ έξρνληαη ζε επαθή ηα δόληηα ζην ζεκείν θιίζεο.  

 

Από ην ηξίγσλν O1a1p (΢ρήκα 3.5), κπνξεί λα πξνζδηνξηζηεί ε αθηίλα 

θακππιόηεηαο ησλ δνληηώλ γξαλαδηώλ: 
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΢ρήκα 3.5: Γεσκεηξία γξαλαδηνύ κε επζείο νδόληεο. (Σν ζρήκα έρεη παξζεί από Boris M. 

Klebanov, David M. Barlam, Machine elements Life and Design, CRC Press Taylor & 
Francis Group, New York 2008) 

 

0

1 1 1

2
2 2 1

1

0,5 tan 20 0.5 135.31 0.3638 24.61

24,61 1 24,61

bd mm

mm

  

   

     


    

  

 

Ζ ηζνδύλακε αθηίλα ηεο θακππιόηεηαο είλαη 

24.61 24.61 605.6521
12.3

24.61 24.61 49.22
e mm


  

  

 

Σν κέηξν ειαζηηθόηεηαο ηνπ ράιπβα Δ = 2.1 ∙ 10
5
 N/mm

2
 ,ην κήθνο ηεο 

γξακκήο επαθώλ L=20 mm. Ζ αληηθαηάζηαζε απηώλ ησλ ζηνηρείσλ ζηελ 

Δμίζσζε 3.1 δίλεη: 

 

3 5
23,7 10 2,1 10

0,418 743 /
12,3 20

N mm

  
 

  
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Σν πιάηνο ηεο πεξηνρήο επαθήο ππνινγίδεηαη από ηελ (3.3) 

3

5

3.7 10 12.3
3.04 0.316

20 2.1 10
cb mm

 
 

   

 

4.3.6 ΢ηαηηθή αλάιπζε – Απνηειέζκαηα 

 

Ζ ζηαηηθή αλάιπζε πξαγκαηνπνηήζεθε κε ηελ εηζαγσγή ησλ 

πξνζνκνησκάησλ ζην πξόγξακκα, όπσο θαίλεηαη ζην ΢ρήκα 3.6. ΢ηελ εηθόλα 
απηή απεηθνλίδεηαη έλα πξνζνκνησκέλν γξαλάδη κε ηηο ζηεξίμεηο θαη ηα θνξηία 

ηνπ έηζη όπσο πξνζνκνηώζεθαλ, ελώ είλαη εκθαλήο ε δηαθξηηνπνίεζε ζε 
πεπεξαζκέλα ζηνηρεία.  

 

 

΢ρήκα 3.6: Πξνζνκνίσζε γξαλαδηνύ. 
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Γξαλάδη ρσξίο ξσγκή (1ε δηαθξηηνπνίεζε) 

 

Ζ παξακνξθσκέλε θαηάζηαζε θαη ε θαηαλνκή ησλ κεηαηνπίζεσλ ηνπ 
γξαλαδηνύ ρσξίο ξσγκή παξνπζηάδνληαη ζηα ΢ρήκαηα 3.7 θαη 3.8. Ζ κέγηζηε 
νξηδόληηα κεηαηόπηζε ηνπ δνληηνύ ηνπ γξαλαδηνύ είλαη 0.746

 
mm θαη 

εκθαλίδεηαη ζην ζεκείν επαθήο ηνπ δνληηνύ.  

 

 

΢ρήκα 3.7: Παξακόξθσζε γξαλαδηνύ ρσξίο ξσγκή. 
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΢ρήκα 3.8: Καηαλνκή κεηαηνπίζεσλ γξαλαδηνύ ρσξίο ξσγκή. 
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Ζ θαηαλνκή ησλ ηάζεσλ ηνπ γξαλαδηνύ ρσξίο ξσγκή παξνπζηάδεηαη ζην 

΢ρήκα 3.9. Οη ζπγθέληξσζε ησλ ηάζεσλ εκθαλίδνληαη ζηε βάζε ηνπ δνληηνύ 
όπνπ έρνπκε ηε κέγηζηε ηηκή ηεο ηάζεο 73.857 N/mm

2
.  

 

 

΢ρήκα 3.9: Καηαλνκή ηάζεσλ γξαλαδηνύ ρσξίο ξσγκή. 
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Γξαλάδη ρσξίο ξσγκή (2ε δηαθξηηνπνίεζε) 

 

Ζ παξακνξθσκέλε θαηάζηαζε θαη ε θαηαλνκή ησλ κεηαηνπίζεσλ ηνπ 
γξαλαδηνύ ρσξίο ξσγκή παξνπζηάδνληαη ζηα ΢ρήκαηα 3.10 θαη 3.11. Ζ κέγηζηε 
νξηδόληηα κεηαηόπηζε ηνπ δνληηνύ ηνπ  γξαλαδηνύ είλαη 0,750 mm θαη 

εκθαλίδεηαη ζην ζεκείν επαθήο ηνπ δνληηνύ.  

 

 

΢ρήκα 3.10: Παξακόξθσζε γξαλαδηνύ ρσξίο ξσγκή 
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΢ρήκα 3.11: Καηαλνκή κεηαηνπίζεσλ γξαλαδηνύ ρσξίο ξσγκή 
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Ζ θαηαλνκή ησλ ηάζεσλ ηνπ γξαλαδηνύ ρσξίο ξσγκή παξνπζηάδεηαη ζην 

΢ρήκα 3.12. Οη ζπγθέληξσζε ησλ ηάζεσλ εκθαλίδνληαη ζηε βάζε ηνπ δνληηνύ 
όπνπ έρνπκε ηε κέγηζηε ηηκή ηεο ηάζεο 73.156 N/mm

2
.  

 

 

΢ρήκα 3.12: Καηαλνκή ηάζεσλ γξαλαδηνύ ρσξίο ξσγκή 

 

Πίλαθαο 3.3: Απνηειέζκαηα ηάζεσλ – κεηαηνπίζεσλ ζην γξαλάδη ρσξίο ξσγκή. 

  

1
ε
 δηαθξηηνπνίεζε 

 

2
ε
 

δηαθξηηνπνίεζε 

 

Μέγηζηεο 
κεηαηνπίζεηο 

(mm) 

 

0.746
 

 

0.750
 

Μέγηζηεο 

ηάζεηο 

(N/mm
2
) 

 

73.857 

 

73.156 
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Σα απνηειέζκαηα ηνπ Πίλαθα 3.3 καο δείρλνπλ όηη δελ ππάξρνπλ κεγάιεο 

απνθιίζεηο ζηελ ζπγθέληξσζε ηάζεσλ θαη ζηηο κεηαηνπίζεηο ηνπ γξαλαδηνύ 
ρσξίο ξσγκή. 

 

3.4 ΓΡΑΝΑΕΗ ΜΔ ΡΧΓΜΖ 

 

Μεηά από ηελ νινθιήξσζε ηεο ζηαηηθήο κειέηεο ηνπ γξαλαδηνύ ρσξίο 

ξσγκή, πξνζδηνξίζηεθε ην ζεκείν ζπγθέληξσζεο ηάζεσλ ζην γξαλάδη θαη κε 
ηελ βνήζεηα ηνπ ANSYS ππνινγίζηεθε θαη ε γσλία ησλ θύξησλ ηάζεσλ θαη έηζη 

ζρεδηάζηεθε ε ξσγκή. ΢ηνλ Πίλαθα 3.4 θαίλνληαη ηα απαηηνύκελα ζηνηρεία 
ζρεδηαζκνύ θαη ε θιίζε ηεο ξσγκήο. 

 

Πίλαθαο 3.4: Απαηηνύκελα ζηνηρεία ζρεδηαζκνύ 

Ολνκαζία 

(΢ύκβνιν) 

Σηκή - Μνλάδεο 

Module (m) 8 

Αξηζκόο δνληηώλ (Z 
ή N) 

18 

Μέηξν 
ειαζηηθόηεηαο (Δ) 

2.1 ∙ 10
5
  N/mm

2
 

Λόγνο Poison (v) 0.3 

Ρνπή (Σ) 25*10
4
 Ν*mm 

Μήθνο ξσγκήο 6.5 mm 

Αξρή ξσγκήο Υ (9.10), Τ(76.16) 

Σειείσκα ξσγκήο Υ (5.85), Τ(70.00) 

Κιίζε ξσγκήο 62
0
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΢ρήκα 3.13: Γξαλάδη κε ξσγκή. 

 

Σν γξαλάδη απηό επεηδή έρεη ηελ ξσγκή ζα απνηειείηαη από δύν 
επηθάλεηεο νύησο ώζηε κε ηελ εθαξκνγή ηνπ θνξηίνπ λα θαλεί ε ξσγκή. Ο 

ηξόπνο ζηήξημεο θαη θόξηηζεο είλαη ν ίδηνο όπσο θαη γηα ην γξαλάδη ρσξίο 
ξσγκή. Ζ δηαθξηηνπνίεζε ζα γίλεη κε ηα ίδηα ζηνηρεία όπσο γηα ην γξαλάδη 

ρσξίο ξσγκή κε ηελ κόλε δηαθνξά όηη ηα ζηνηρεία ηεο πεξηνρήο γύξσ από ηε 
ξσγκή ζα είλαη εηδηθνύ ηύπνπ, όπσο αθξηβώο ζηελ Παξάγξαθν 2.3.  
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3.4.1 Γηαθξηηνπνίεζε γξαλαδηνύ  

 

Ρεγκαησκέλν γξαλάδη   (1ε δηαθξηηνπνίεζε) 

 

Ζ παξακνξθσκέλε θαηάζηαζε θαη ε θαηαλνκή ησλ κεηαηνπίζεσλ ηνπ 
ξεγκαησκέλνπ γξαλαδηνύ παξνπζηάδνληαη ζηα ΢ρήκαηα 3.14 θαη 3.15. Ζ 

κέγηζηε νξηδόληηα κεηαηόπηζε ηνπ γξαλαδηνύ είλαη 0,930 mm . 

 

 

΢ρήκα 3.14: Παξακόξθσζε ξεγκαησκέλνπ γξαλαδηνύ. 
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΢ρήκα 3.15: Καηαλνκή κεηαηνπίζεσλ ξεγκαησκέλνπ γξαλαδηνύ. 
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Ζ θαηαλνκή ησλ ηάζεσλ ηνπ ξεγκαησκέλνπ γξαλαδηνύ παξνπζηάδεηαη 

ζην ΢ρήκα 3.16. Οη ζπγθέληξσζε ησλ ηάζεσλ εκθαλίδνληαη ζηελ άθξε ηεο 
ξσγκήο όπνπ έρνπκε ηε κέγηζηε ηηκή ηεο ηάζεο 127.817 N/mm

2
.  

 

 

΢ρήκα 3.16: Καηαλνκή ηάζεσλ ξεγκαησκέλνπ γξαλαδηνύ. 
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Ρεγκαησκέλν γξαλάδη   (2ε δηαθξηηνπνίεζε) 

 

Ζ παξακνξθσκέλε θαηάζηαζε θαη ε θαηαλνκή ησλ κεηαηνπίζεσλ ηνπ 
ξεγκαησκέλνπ γξαλαδηνύ παξνπζηάδνληαη ζηα ΢ρήκαηα 3.17 θαη 3.18. Ζ 

κέγηζηε νξηδόληηα κεηαηόπηζε ηνπ γξαλαδηνύ είλαη 0,932 mm . 

 

 

΢ρήκα 3.17: Παξακόξθσζε ξεγκαησκέλνπ γξαλαδηνύ. 
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΢ρήκα 3.18: Καηαλνκή κεηαηνπίζεσλ ξεγκαησκέλνπ γξαλαδηνύ. 
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Ζ θαηαλνκή ησλ ηάζεσλ ηνπ ξεγκαησκέλνπ γξαλαδηνύ παξνπζηάδεηαη 

ζην ΢ρήκα 3.19. Οη ζπγθέληξσζε ησλ ηάζεσλ εκθαλίδνληαη ζηελ άθξε ηεο 
ξσγκήο όπνπ έρνπκε ηε κέγηζηε ηηκή ηεο ηάζεο 160.326 N/mm

2
.  

 

 

΢ρήκα 3.19: Καηαλνκή ηάζεσλ ξεγκαησκέλνπ γξαλαδηνύ. 

 

Πίλαθαο 3.5: Απνηειέζκαηα ηάζεσλ – κεηαηνπίζεσλ ζην γξαλάδη ρσξίο ξσγκή. 

  

1
ε
 δηαθξηηνπνίεζε 

 

2
ε
 δηαθξηηνπνίεζε 

 

Μέγηζηεο 
κεηαηνπίζεηο 

(mm) 

 

0.930
 

 

0.932
 

Μέγηζηεο 
ηάζεηο 

(N/mm
2
) 

 

127.817 

 

160.326   
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Σα απνηειέζκαηα ηνπ Πίλαθα 3.5 καο δείρλνπλ όηη ππάξρεη θάπνηα απόθιηζε 

ζηελ ηάζε ζηελ άθξε ηεο ξσγκήο. Απηό ζπκβαίλεη γηαηί όζν κεγαιύηεξε 
δηαθξηηνπνίεζε θάλνπκε ζην γξαλάδη, ηόζν πεξηζζόηεξν πιεζηάδνπκε ζηελ 
άθξε ηεο ξσγκήο κε απνηέιεζκα λα έρνπκε κεγαιύηεξε ζπγθέληξσζε ηάζεσλ, 

πξάγκα πνπ είλαη ινγηθό. 

 

3.5 ΤΠΟΛΟΓΗ΢ΜΟ΢ ΢ΤΝΣΔΛΔ΢ΣΖ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ 

 

Γηα θαιύηεξε αθξίβεηα ηνπ απνηειέζκαηνο ηνπ ζπληειεζηή έληαζεο 

ηάζεο, ππνινγίζηεθε γηα ηηο δύν δηαθξηηνπνηήζεηο πνπ έγηλαλ παξαπάλσ γηα ηηο 
ηάζεηο θαη ηηο κεηαηνπίζεηο.  

 

΢πληειεζηήο έληαζεο ηάζεο (1
ε
 δηαθξηηνπνίεζε) 

Κ1=361.68 N/mm
2

mm  

΢πληειεζηήο έληαζεο ηάζεο (2
ε
 δηαθξηηνπνίεζε) 

Κ1=363.30 N/mm
2

mm  

 

Παξαηεξνύκε όηη νη ηηκέο ηνπ ζπληειεζηή έληαζεο ηάζεο ζπγθιίλνπλ. 
Άξα ν ππνινγηζκόο ήηαλ επηηπρήο. Δπίζεο, πξέπεη ζην ζεκείν απηό λα 

αλαθέξνπκε όηη ζύκθσλα κε ηνλ πίλαθα 3.1 ν θξίζηκνο ζπληειεζηήο έληαζεο 

ηάζεο είλαη 1581 N/mm
2

mm . Παξαηεξνύκε όηη ηα απνηειέζκαηα ησλ 
ππνινγηζκώλ είλαη πνιύ κηθξόηεξα απηήο ηεο ηηκήο άξα δελ ππάξρεη θάπνπ 

αζηνρία ηνπ πιηθνύ.  
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ΠΑΡΑΡΣΖΜΑ: 

 

ΒΖΜΑ ΠΡΟ΢ ΒΖΜΑ ΚΑΣΑ΢ΚΔΤΖ ΣΧΝ ΜΟΝΣΔΛΧΝ 

(TUTORIALS) TΧΝ ΠΡΟΒΛΖΜΑΣΧΝ ΣΟΤ ΚΔΦΑΛΑΗΟΤ 2 

 

Π.1 ΠΡΟΒΛΖΜΑ 2.1: ΑΝΑΛΤ΢Ζ ΔΠΗΠΔΓΖ΢ ΟΡΘΟΓΧΝΗΑ΢ ΠΛΑΚΑ΢ ΜΔ ΟΠΖ 

 

Βήκα 1: Έλαξμε ηνπ Πξνγξάκκαηνο 

Αλνίγνπκε ην πξόγξακκα ANSYS, δίλνπκε ηίηιν (job name), επηιέγνπκε ηελ 
εληνιή run. Με απηό ην ηξόπν εκθαλίδεηαη ην πεξηβάιινλ εξγαζίαο ηνπ ANSYS 

όπσο απεηθνλίδεηαη παξαθάησ: 

 

 

 

Βήκα 2: Γεωκεηξία ηεο θαηαζθεπήο     

 

Α) Γεκηνπξγία παξαιιεινγξάκκνπ  

Μπαίλνπκε ζην θπξίσο κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά, ζην 
(preprocessor) γηα λα δεκηνπξγήζνπκε ην παξαιιειόγξακκν. 

Preprocessor > Modeling > Create > Areas > Rectangle > by 2 Corners 
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΢ην εηθνλίδην πνπ εκθαλίδεηαη δίλνπκε ύςνο (height)=0.2, πιάηνο (width)=0.5 

θαη επηιέγνπκε ΟΚ. Έηζη ζηελ επηθάλεηα εξγαζίαο εκθαλίδεηαη ην 
παξαιιειόγξακκν κε ηηο παξαπάλσ δηαζηάζεηο: 

 

 

 

Β) Γεκηνπξγία θύθινπ  

Οκνίσο ιεηηνπξγνύκε γηα ηε ζρεδίαζε ηνπ θύθινπ. Μπαίλνπκε  ζην θπξίσο 
κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά: 

Preprocessor > Modeling > Create > Areas > Circle > Solid Circle 
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΢ηε θαξηέια πνπ εκθαλίδεηαη δίλνπκε ζπληεηαγκέλεο (x,y)=(0,0), αθηίλα 

(radius)=0.1 θαη επηιέγνπκε ΟΚ. 

 

 

 

 

 

Γ) Γεκηνπξγία νπήο 

Γηα λα δεκηνπξγήζνπκε ηελ νπή θόβνπκε ηελ επηθάλεηα ηνπ θύθινπ. Από ην 

αξηζηεξό κελνύ επηιέγνπκε: Preprocessor > Modeling > Operate > Booleams 
> Substract > Areas. Δπηιέγνληαο ηελ επηθάλεηα πνπ ζέινπκε λα θξαηήζνπκε 

εκθαλίδεηε ην παξαθάησ εηθνλίδην ζην νπνίν παηάκε ΟΚ. Από ηελ θαξηέια 
(substract areas) επηιέγνπκε Apply,  ζηε ζπλέρεηα δηαιέγνπκε ηελ επηθάλεηα 

πνπ ζέινπκε λα θόςνπκε θαη παηάκε ΟΚ ζηηο αληίζηνηρεο θαξηέιεο. 
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Ζ ηειηθή κνξθή ηνπ κνληέινπ απεηθνλίδεηαη παξαθάησ: 

 

 

 

Βήκα 3: Οξηζκόο ζηνηρείωλ 

 

Οξηζκόο ζηνηρείνπ επηθάλεηαο πιάθαο Solid: Από ην αξηζηεξό κελνύ: 

Preprocessor > Element type > Add/edit/delete 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε add θαη ζηε λέα θαξηέια επηιέγνπκε 
solid triangle 6node 2 θαη παηάκε ΟΚ. 
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Πξηλ θιείζνπκε ηελ θαξηέια (element type) παηάκε ηελ επηινγή options θαη καο 

εκθαλίδεηαη κηα θαξηέια όπνπ γηα (element behavior) επηιέγνπκε plane stress 
w/thk. 

 

 

 

Βήκα 4: Καζνξηζκόο γεωκεηξηθώλ ηδηνηήηωλ 

 

Σν πάρνο ηεο πιάθαο ζα νξηζηεί ζαλ ηδηόηεηα ηνπ πιηθνύ σο εμήο: 

Preprocessor menu > Real constants > Add/edit/delete 

Θα εκθαληζηεί κηα θαξηέια ζηελ νπνία ζα νξίζνπκε πάρνο (thk)=0.01 
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Βήκα 5: Ηδηόηεηεο πιηθνύ 

Ο νξηζκόο ηνπ πιηθνύ ηεο πιάθαο γίλεηαη σο εμήο: Από ην αξηζηεξό κελνύ 
Preprocessor  > Material Props  > Material models > Structrural > Linear 

> Elastic > Isotropic. ΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ην κέηξν 
ειαζηηθόηεηαο EX: 2.07E11 θαη ην ιόγν Ρoisson PRXY: 0.29 

 

 

 

Βήκα 6: Γηαθξηηνπνίεζε πιάθαο (πξώην πιέγκα) 

Γηαθξηηνπνηνύκε ηελ επηθάλεηα σο εμήο: Δπηιέγνπκε από ην αξηζηεξό κελνύ 
Preprocessor > Meshing > Mesh > Areas > Free 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All γηα λα επηιεγεί όιε ε επηθάλεηα 

πνπ ζέινπκε λα δηαθξηηνπνηεζεί. ΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ε πιάθα 
κε ην πξώην κέγεζνο πιέγκαηνο.  
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Βήκα 7: Οξηζκόο είδνπο αλάιπζεο 

Οξίδνπκε ην είδνο ηεο αλάιπζεο σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor 
> Loads > Analysis Type>New Analysis. ΢ηε θαξηέια πνπ εκθαλίδεηαη 

επηιέγνπκε Static. 

 

Βήκα 8: Οξηζκόο ζηεξίμεωλ  

Γηα λα νξίζνπκε ηηο ζηεξίμεηο ηεο πιάθαο εθηεινύκε ηηο παξαθάησ ελέξγεηεο: 

Από ην αξηζηεξό κελνύ Preprocessor > Loads  > Define Loads > Apply > 
Structural  > Displacement > On Lines επηιέγνπκε ηελ αξηζηεξή γξακκή όπνπ 

ζέινπκε λα ηνπνζεηήζνπκε ηηο ζηεξίμεηο, παηάκε ΟΚ θαη ζηε θαξηέια πνπ 
εκθαλίδεηαη επηιέγνπκε κόλν ηνλ Τ άμνλα (UΤ). 
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Δπηιέγνπκε ΟΚ θαη εκθαλίδνληαη νη ζηεξίμεηο ζηελ πιάθα όπσο απεηθνλίδεηαη 
ζην παξαθάησ ζρήκα: 

 

 

 

Βήκα 9: Οξηζκόο θνξηίνπ 

Γηα λα νξίζνπκε ηε ηηκή θαη ηε δηεύζπλζε ηνπ θνξηίνπ αθνινπζνύκε ηηο εμήο 
εληνιέο: Preprocessor > Loads >Define Loads > Apply > Structural 

>Pressure > On Lines. ΢ηε ζπλέρεηα επηιέγνπκε ηε δεμηά γξακκή ηεο πιάθαο, 
παηάκε ΟΚ θαη ζηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ηε ηηκή ηνπ 

θνξηίνπ (-1). Σν θνξηίν έρεη αξλεηηθό πξόζεκν δηόηη ην ANSYS 
αληηιακβάλεηαη ηα εθειθπζηηθά θνξηία σο αξλεηηθά θαη ηα ζιηπηηθά σο ζεηηθά. 
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Δπηιέγνληαο ΟΚ απεηθνλίδεηαη ε ηειηθή κνξθή ηνπ πξνβιήκαηνο πξηλ ηελ 

επίιπζε (Solve). 
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Bήκα 10: Δπίιπζε ηνπ ζπζηήκαηνο  

Δθηεινύκε ηελ επίιπζε από ην αξηζηεξό κελνύ Solution > Solve > Current Ls. 
Όηαλ ηειεηώζνπλ νη ππνινγηζκνί ην πξόγξακκα καο ελεκεξώλεη κε ην κήλπκα 

Solution is done. 

 

Bήκα 11: Πξνβνιή απνηειεζκάηωλ 

Α) Παξακνξθσκέλν ζώκα: Σν ANSYS καο δίλεη ηελ δπλαηόηεηα απεηθόληζεο 

ηνπ παξακνξθσκέλνπ ζώκαηνο ζε αληηπαξάζεζε κε ην αξρηθό. Γνπιεύνπκε 
πάιη από ην αξηζηεξό κελνύ ηνπ πξνγξάκκαηνο αθνινπζώληαο ηηο εληνιέο: 

General Postproc > Plot results > Deformed shape > Def+underformd. 
Aθνπ εθηειέζνπκε όια ηα παξαπάλσ επηιέγνπκε ΟΚ ζηελ θαξηέια πνπ έρεη 

εκθαληζηεί. Σν απνηέιεζκα είλαη:   

 

 

 

Β) Καηαλνκή ησλ κεηαηνπίζεσλ: Από ην αξηζηεξό κελνύ επηιέγνπκε General 

Postproc  > Plot Results > Contour Plot > Nodal Solution. ΢ηελ θαξηέια πνπ 
εκθαλίδεηαη επηιέγνπκε Dof solution > Displacement vector sum, παηάκε ΟΚ 

θαη εκθαλίδεηαη ην παξαθάησ ζρήκα: 
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Γ) Καηαλνκή ησλ ηάζεσλ: Δθηεινύκε ηελ ίδηα δηαδηθαζία: General Postproc > 
Plot Results > Contour Plot  > Nodal Solution. ΢ηελ θαξηέια πνπ εκθαλίδεηαη 

επηιέγνπκε Stress > von Mises Stress θαη παηάκε ΟΚ. 
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Γ) Λίζηεο απνηειεζκάησλ: Αλ ζέινπκε λα δνύκε ηα απνηειέζκαηα ησλ ηάζεσλ 

ζε όινπο ηνπο θόκβνπο (nodes) ή ζε όια ηα ζηνηρεία (elements) αθνινπζνύκε 
ηελ εμήο δηαδηθαζία: General Postproc > List Results > Nodal Solution > 
Stress > Von Mises Stress  θαη επηιέγνπκε ΟΚ. 

 

 

Βήκα 12: Γηαθξηηνπνίεζε πιάθαο (δεύηεξν πιέγκα) 

Με ζθνπό ηελ πηζηνπνίεζε ηεο ζύγθιηζεο ησλ απνηειεζκάησλ, ε πιάθα 
δηαθξηηνπνηείηαη πάιη κε δηαθνξεηηθό κέγεζνο ζηνηρείσλ: Preprocessor > 

Meshing > Modify Mesh > Refine At > All. ΢ην θαξηειάθη πνπ εκθαλίδεηαη 
παξαθάησ επηιέγνπκε ΟΚ. 

 

 

 

΢ην παξαθάησ ζρήκα απεηθνλίδεηαη ε πιάθα κε ην δεύηεξν κέγεζνο πιέγκαηνο: 

 

 



 

 

85 

Έπεηηα, επεηδή ζέινπκε λα ην κειεηήζνπκε εθηελέζηεξα θνληά ζηελ νπή ζα ην 

δηαθξηηνπνηήζνπκε κε ην ρέξη ζε θάπνηνπο θόκβνπο, Preprocessor > Meshing 
> Modify Mesh > Refine At > Nodes θαη επηιέγνπκε ηνπο θόκβνπο πνπ 
θαίλνληαη παξαθάησ: 

 

 

 

 

 

Λύλνπκε ην ζύζηεκα Solution > Solve > Current Ls θαη παίξλνπκε ηα λέα 
απνηειέζκαηα: 

 

Α) Παξακνξθσκέλν ζώκα: Ceneral Postproc > Plot Results > Deformed 
Shape > Def+underformd. Aθνύ εθηειέζνπκε όια ηα παξαπάλσ επηιέγνπκε 

ΟΚ ζηε θαξηέια πνπ έρεη εκθαληζηεί. Σν απνηέιεζκα είλαη: 
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Β) Καηαλνκή ησλ κεηαηνπίζεσλ: Από ην αξηζηεξό κελνύ επηιέγνπκε General 
Postproc  > Plot Results > Contour Plot > Nodal Solution. ΢ηε θαξηέια πνπ 

εκθαλίδεηαη επηιέγνπκε Dof solution > Displacement vector sum, παηάκε ΟΚ 
θαη εκθαλίδεηαη ην παξαθάησ ζρήκα: 
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Γ) Καηαλνκή ησλ ηάζεσλ: Δθηεινύκε πάιη ηελ ίδηα δηαδηθαζία: General 

Postproc > Plot Results > Contour Plot > Nodal Solution. ΢ηελ θαξηέια πνπ 
εκθαλίδεηαη επηιέγνπκε Stress > von Mises Stress θαη παηάκε ΟΚ. 

 

 

 

 

 

Π.2 ΠΡΟΒΛΖΜΑ 2.2: ΚΑΘΟΡΗ΢ΜΟ΢ ΣΧΝ ΣΑ΢ΔΧΝ ΚΑΗ ΣΧΝ 

ΠΑΡΑΜΟΡΦΧ΢ΔΧΝ ΣΜΖΜΑΣΟ΢ ΣΖ΢ ΕΧΝΖ΢ Α΢ΦΑΛΔΗΑ΢  

 

Βήκα 1: Γεωκεηξία ηεο θαηαζθεπήο 

Οξίδνπκε ζεκεία (keypoints) σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor > 

Modeling > Create > Keypoints επηιέγνπκε In Active CS. 
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΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ζην πεδίν X,Y,Z Location in 

active CS ηηο ζπληεηαγκέλεο ησλ απαηηνύκελσλ γηα ηνλ νξηζκό ηεο γεσκεηξίαο 
keypoints. Δηζάγνπκε ην πξώην ζεκείν (keypoint) ζην θαηάιιειν παξάζπξν, 

πιεθηξνινγώληαο ηηο x,y ζπληεηαγκέλεο: 0,0 (όπσο παξνπζηάδεηαη θαησηέξσ). 
Δπηιέγνπκε Apply γηα λα δερηεί ό,ηη έρνπκε δαθηπινγξαθήζεη. Δηζάγνπκε θαη 

ηα ππόινηπα ζεκεία (keypoints) ρξεζηκνπνηώληαο ηελ ίδηα κέζνδν. 

΢εκείωζε:  Καηά ηελ είζνδν ηνπ ηειηθνύ ζεκείνπ ζηνηρείσλ, επηιέγνπκε OK 

γηα λα δείμνπκε όηη έρνπκε ηειεηώζεη ηε δηαδηθαζία εηζόδνπ ησλ ζπληεηαγκέλσλ 
ησλ ζεκείσλ (keypoints). Δάλ παηήζνπκε αξρηθά Apply θαη έπεηηα OK γηα ην 

ηειηθό keypoint, ζα ην έρoπκε θαζνξίζεη δύν θνξέο. Δάλ επηιέμνπκε Apply γηα 
ην ηειηθό ζεκείν, παηάκε απιά Cancel γηα λα θιείζνπκε ηελ θαξηέια. 

 

 

 

Οη απαηηνύκελεο ζπληεηαγκέλεο γηα ηε δεκηνπξγία ησλ ζεκείσλ (keypoints) ηνπ 
κνληέινπ καο απεηθνλίδνληαη ζηνλ Πίλαθα Π.1: 
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Πίλαθαο Π.1: ΢πληεηαγκέλεο ζεκείσλ 

΢εκεία 

(Keypoints) 

 

X 

 

Y 

1 0 0 

2 0.75 0 

3 1.125 0 

4 1.5 0 

5 1.5 0. 5 

6 1.25 0.75 

7 0 0.75 

8 1.125 0.375 

9 1.09375 0.40625 

10 0.8125 0.40625 

11 0.75 0.34375 

12 1.25 0.5 

13 1.09375 0.375 

14 0.8125 0.34375 

 

 

Βήκα 2: Γεκηνπξγία γξακκώλ 

Δλώλνληαο ηα ζεκεία (keypoints) νξίδνπκε γξακκέο (Lines) σο εμήο: Από ην 

αξηζηεξό κελνύ Preprocessor > Modeling > Create > Lines > Lines 
επηιέγνπκε In Active Coord. Σηο γξακκέο ηηο νξίδνπκε είηε ζπκπιεξώλνληαο, 

ζηελ θαξηέια πνπ εκθαλίδεηαη, ηα δπν ζεκεία (keypoints) ζην edit box ηνπ 
πεδίνπ List of items, είηε παηώληαο αξηζηεξό click πάλσ ζηα ζεκεία (keypoints). 
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Δλώλνληαο όια ηα ζεκεία εκθαλίδεηαη ην παξαθάησ ζρήκα: 

 

 

 

Γηα λα νινθιεξσζεί ζα πξέπεη λα θηηάμνπκε θαη ηα ηόμα πνπ ελώλνπλ ηηο 
γξακκέο Preprocessor > Modeling > Create > Arcs >By End KPs & Rad 

επηιέγνπκε ηηο γξακκέο πνπ ζέινπκε λα ελώζνπκε θαη ηελ αθηίλα ηνπ ηόμνπ θαη 
παηάκε OK: 
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Βήκα 3: Γεκηνπξγία επηθάλεηαο 

Μπαίλνπκε ζην θπξίσο κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά, ζην 
(preprocessor) γηα λα δεκηνπξγήζνπκε ηελ πεξηνρή. 

Preprocessor > Modeling > Create > Areas > Rectangle >By Lines 

Καη επηιέγνπκε όιεο ηηο γξακκέο θαη παηάκε ΟΚ. 
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Βήκα 4: Οξηζκόο ζηνηρείωλ 

Οξηζκόο ζηνηρείνπ επηθάλεηαο πιάθαο Solid: Από ην αξηζηεξό κελνύ: 

Preprocessor > Element type > Add/edit/delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε add θαη ζηε λέα θαξηέια επηιέγνπκε 

solid 8node 183 θαη παηάκε ΟΚ. 
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Πξηλ θιείζνπκε ηελ θαξηέια (element type) παηάκε ηελ επηινγή options θαη καο 

εκθαλίδεηαη κηα θαξηέια όπνπ γηα (element behavior) επηιέγνπκε plane stress 
w/thk. 

 

 

 

 

 

Βήκα 5: Καζνξηζκόο γεωκεηξηθώλ ηδηνηήηωλ 

Σν πάρνο ηεο πιάθαο ζα νξηζηεί ζαλ ηδηόηεηα ηνπ πιηθνύ σο εμήο: 

Preprocessor menu > Real constants >Add/edit/delete. 

Θα εκθαληζηεί κηα θαξηέια ζηελ νπνία ζα νξίζνπκε πάρνο (thk)=2. 
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Βήκα 6: Ηδηόηεηεο πιηθνύ 

Ο νξηζκόο ηνπ πιηθνύ ηεο πιάθαο γίλεηαη σο εμήο: Από ην αξηζηεξό κελνύ 
Preprocessor > Material Props > Material models > Structrural > Linear > 

Elastic > Isotropic. ΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ην κεηξό 
ειαζηηθόηεηαο EX: 3.0Δ7 θαη ην ιόγν Ρoisson PRXY: 0.3. 

 

 

 

Βήκα 7: Γηαθξηηνπνίεζε πιάθαο  

Γηαθξηηνπνηνύκε ηελ επηθάλεηα σο εμήο: Δπηιέγνπκε από ην αξηζηεξό κελνύ 
Preprocessor > Meshing > Mesh > Areas > Free 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All γηα λα επηιεγεί όιε ε επηθάλεηα 

πνπ ζέινπκε λα δηαθξηηνπνηεζεί.  
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Βήκα 8: Οξηζκόο είδνπο αλάιπζεο 

Οξίδνπκε ην είδνο ηεο αλάιπζεο σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor 
> Loads > Analysis Type > New Analysis. ΢ηελ θαξηέια πνπ εκθαλίδεηαη 

επηιέγνπκε Static. 

 

Βήκα 9: Οξηζκόο ζηεξίμεωλ  

Γηα λα νξίζνπκε ηηο ζηεξίμεηο ηεο πιάθαο εθηεινύκε ηηο παξαθάησ ελέξγεηεο: 

Από ην αξηζηεξό κελνύ Preprocessor > Loads > Define Loads > Apply > 
Structural  > Displacement  > On Lines επηιέγνπκε ηελ αξηζηεξή γξακκή 

όπνπ ζέινπκε λα ηνπνζεηήζνπκε ηηο ζηεξίμεηο, παηάκε ΟΚ θαη ζηελ θαξηέια 
πνπ εκθαλίδεηαη επηιέγνπκε ηνλ Υ άμνλα (UX=0). 
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Κάλνπκε ην ίδην θαη γηα ηηο θάησ γξακκέο αιιά επηιέγνπκε ηνλ Τ άμνλα 

(UY)=0. 

  

 

 

Δπηιέγνπκε ΟΚ θαη εκθαλίδνληαη νη ζηεξίμεηο ζηελ πιάθα όπσο απεηθνλίδεηαη 

ζην παξαθάησ ζρήκα: 
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Βήκα 10: Οξηζκόο θνξηίνπ 

Γηα λα νξίζνπκε ηε ηηκή θαη ηε δηεύζπλζε ηνπ θνξηίνπ αθνινπζνύκε ηηο εμήο 
εληνιέο: Preprocessor > Loads > Define Loads > Apply >  Structural > 

Pressure > On Lines. ΢ηε ζπλέρεηα επηιέγνπκε ηε δεμηά γξακκή ηεο πιάθαο, 
παηάκε ΟΚ θαη ζηε θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ηε ηηκή ηνπ 

θνξηίνπ (14000).  
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Δπηιέγνληαο ΟΚ απεηθνλίδεηαη ε ηειηθή κνξθή ηνπ πξνβιήκαηνο πξηλ 

πξνβνύκε ζηελ επίιπζε (Solve). 

 

 

 

 

Bήκα 11: Δπίιπζε ηνπ ζπζηήκαηνο  

Δθηεινύκε ηελ επίιπζε από ην αξηζηεξό κελνύ Solution > Solve > Current Ls. 
Όηαλ ηειεηώζνπλ νη ππνινγηζκνί ην πξόγξακκα καο ελεκεξώλεη κε ην κήλπκα 

Solution is done. 

 

Bήκα 12: Πξνβνιή απνηειεζκάηωλ 

Α) Παξακνξθσκέλν ζώκα: Σν ANSYS καο δίλεη ηελ δπλαηόηεηα απεηθόληζεο 

ηνπ παξακνξθσκέλνπ ζώκαηνο ζε αληηπαξάζεζε κε ην αξρηθό. Γνπιεύνπκε 
πάιη από ην αξηζηεξό κελνύ ηνπ πξνγξάκκαηνο αθνινπζώληαο ηηο εληνιέο: 

General Postproc > Plot results > Deformed shape > Def+underformd. 
Aθνπ εθηειέζνπκε όια ηα παξαπάλσ επηιέγνπκε ΟΚ ζηελ θαξηέια πνπ έρεη 

εκθαληζηεί. Σν απνηέιεζκα είλαη:   
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Β) Καηαλνκή ησλ κεηαηνπίζεσλ: Από ην αξηζηεξό κελνύ επηιέγνπκε General 

Postproc > Plot Results > Contour Plot > Nodal Solution. ΢ηελ θαξηέια πνπ 
εκθαλίδεηαη επηιέγνπκε Dof solution > Displacement vector sum, παηάκε ΟΚ 

θαη εκθαλίδεηε ην παξαθάησ ζρήκα: 
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Γ) Καηαλνκή ησλ ηάζεσλ: Δθηεινύκε πάιη ηελ ίδηα δηαδηθαζία: General 

Postproc > Plot Results > Contour Plot > Nodal Solution. ΢ηελ θαξηέια πνπ 
εκθαλίδεηαη επηιέγνπκε Stress > von Mises Stress θαη παηάκε ΟΚ. 

 

 

 

Γ) Λίζηεο απνηειεζκάησλ: Αλ ζέινπκε λα δνύκε ηα απνηειέζκαηα ησλ ηάζεσλ 
ζε όινπο ηνπο θόκβνπο (nodes) ή ζε όια ηα ζηνηρεία (elements) αθνινπζνύκε 

ηελ εμήο δηαδηθαζία: General Postproc > List Results > Nodal Solution > 
Stress > von Mises Stress  θαη επηιέγνπκε ΟΚ 

 

Π.3 ΠΡΟΒΛΖΜΑ 2.3: ΔΤΡΔ΢Ζ ΣΟΤ ΢ΤΝΣΔΛΔ΢ΣΖ ΔΝΣΑ΢Ζ΢ ΠΛΑΚΑ΢ ΜΔ 

ΡΧΓΜΖ ΢ΣΖΝ ΜΔ΢Ζ  

 

΢ηελ πεξίπησζή καο επεηδή ην ζρήκα καο είλαη ζπκκεηξηθό θαη νη δπλάκεηο θαη 
νη πηέζεηο πνπ αζθνύληαη είλαη ζπκκεηξηθέο θαη απηέο ζα κειεηήζνπκε ην ¼ ηεο 

πιάθαο. 

 

Βήκα 1: Οξηζκόο ζεκείωλ  

Οξίδνπκε ζεκεία (keypoints) σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor > 

Modeling > Create > Keypoints επηιέγνπκε In Active CS. 
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΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ζην πεδίν X,Y,Z Location in 

active CS ηηο ζπληεηαγκέλεο ησλ απαηηνύκελσλ γηα ηνλ νξηζκό ηεο γεσκεηξίαο 
keypoints. Δηζάγνπκε ην πξώην ζεκείν( keypoint) ζην θαηάιιειν παξάζπξν, 
πιεθηξνινγώληαο ηηο x, y ζπληεηαγκέλεο: 0,0 (όπσο παξνπζηάδεηαη θαησηέξσ). 

Δπηιέγνπκε Apply γηα λα δερηεί όηη έρνπκε δαθηπινγξαθήζεη. Δηζάγνπκε θαη 
ηα ππόινηπα ζεκεία (keypoints) ρξεζηκνπνηώληαο ηελ ίδηα κέζνδν.  

 

 

 

Οη απαηηνύκελεο ζπληεηαγκέλεο γηα ηε δεκηνπξγία ησλ ζεκείσλ (keypoints) ηνπ 

κνληέινπ καο απεηθνλίδνληαη ζην παξαθάησ πίλαθα (Πίλαθαο Π.2): 

 

Πίλαθαο Π.2: ΢πληεηαγκέλεο ζεκείσλ 

΢εκεία  (Keypoints) ΢πληεηαγκέλεο  ( Υ, Τ ) 

1 (0,0) 

2 (0.02, 0) 

3 (0.1,0) 

4 (0.1,0.1) 

5 (0,0.1) 

 

Βήκα 2: Γεκηνπξγία Concentration Keypoint  

Main Menu>Preprocessor>Meshing>Size Cntrls>Concentrat KPs>Create 

Δπηιέγνπκε ην keypoint #2 θαη κεηά παηάκε ΟΚ ζην παξαθάησ παξάζπξν 
εηπινγώλ. 
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΢ην παξαθάησ παξάζπξν πνπ εκθαλίδεηαη πξέπεη λα βάινπκε ‘2’ γηα Keypoint 

for concentration’. Δηζάγνπκε ‘0.0025’ (=a/8) γηα ‘Radius of 1
st
 row of elems’, 

επίζεο βάδνπκε ‘8’ γηα ‘No of elems around circumf’ θαη δηαιέγνπκε ‘Skewed 

¼ pt’ γηα ‘midside node position’. Παηάκε ΟΚ.  
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Βήκα 3: Γεκηνπξγία γξακκήο  

Δλώλνληαο ηα ζεκεία (keypoints) νξίδνπκε γξακκή (Line) σο εμήο: Από ην 
αξηζηεξό κελνύ Preprocessor > Modeling > Create > Lines > Lines 

επηιέγνπκε Straight Line. Σε γξακκή ηελ νξίδνπκε είηε ζπκπιεξώλνληαο, ζηελ 
θαξηέια πνπ εκθαλίδεηαη ηα δπν ζεκεία (Keypoints) ζην edit box ηνπ πεδίνπ 

List of items, είηε παηώληαο αξηζηεξό click πάλσ ζηα ζεκεία (keypoints). 

 

 

 

 

Δλώλνληαο ηα ζεκεία (keypoints) εκθαλίδεηαη ην παξαθάησ ζρήκα : 
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Βήκα 4: Γεκηνπξγία επηθάλεηαο 

Μπαίλνπκε ζην θπξίσο κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά, ζην 
(preprocessor) γηα λα δεκηνπξγήζνπκε ηελ πεξηνρή. 

Preprocessor > Modeling > Create > Areas > Rectangle > By Lines 

Δπηιέγνπκε όιεο ηηο γξακκέο θαη παηάκε ΟΚ. 
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Βήκα 5: Οξηζκόο ζηνηρείωλ 

Οξηζκόο ζηνηρείνπ επηθάλεηαο πιάθαο Solid: Από ην αξηζηεξό κελνύ: 

Preprocessor > Element type > Add/edit/delete 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε add θαη ζηε λέα θαξηέια επηιέγνπκε 
solid 8node 82 θαη παηάκε ΟΚ. 
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Πξηλ θιείζνπκε ηελ θαξηέια (element type) παηάκε ηελ επηινγή options θαη καο 

εκθαλίδεηαη κηα θαξηέια όπνπ γηα (element behavior) επηιέγνπκε Plane strain 

 

 

 

Βήκα 6: Ηδηόηεηεο πιηθνύ 

Ο νξηζκόο ηνπ πιηθνύ ηεο πιάθαο γίλεηαη σο εμήο: Από ην αξηζηεξό κελνύ 

Preprocessor > Material Props > Material models > Structrural > Linear > 
Elastic > Isotropic. ΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ην κέηξν 
ειαζηηθόηεηαο EX: 2Δ5 θαη ην ιόγν Ρoisson PRXY: 0.3 
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Βήκα 7: Γηαθξηηνπνίεζε πιάθαο  

Γηαθξηηνπνηνύκε ηελ επηθάλεηα σο εμήο: Δπηιέγνπκε από ην αξηζηεξό κελνύ 
Preprocessor > Meshing > Mesh > Areas > Free 

Όηαλ εκθαληζηεί ε θαξηέια θάλνπκε αξηζηεξό ζηελ επηθάλεηα γηα λα επηιεγνύλ 

όιεο νη επηθάλεηεο πνπ ζέινπκε λα δηαθξηηνπνηεζνύλ θαη ζηελ θαξηέια παηάκε 
ΟΚ .  

 

 

 

Βήκα 8: Οξηζκόο είδνπο αλάιπζεο 

Οξίδνπκε ην είδνο ηεο αλάιπζεο σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor 
> Loads > Analysis Type > New Analysis. ΢ηελ θαξηέια πνπ εκθαλίδεηαη 

επηιέγνπκε Static 

 

Βήκα 9: Οξηζκόο θνξηίνπ 

Γηα λα νξίζνπκε ηε ηηκή θαη ηε δηεύζπλζε ηνπ θνξηίνπ αθνινπζνύκε ηηο εμήο 
εληνιέο: Preprocessor > Loads > Define Loads > Apply >  Structural > 

Pressure > On Lines. ΢ηελ ζπλέρεηα επηιέγνπκε ηελ πάλσ γξακκή ηεο πιάθαο, 
παηάκε ΟΚ θαη ζηε θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ηελ ηηκή ηνπ 

θνξηίνπ (-100).  
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Δπηιέγνληαο ΟΚ απεηθνλίδεηαη ε ηειηθή κνξθή ηνπ πξνβιήκαηνο πξηλ 

πξνβνύκε ζηελ επίιπζε (Solve). 

 

 

 

Bήκα 10: Δπίιπζε ηνπ ζπζηήκαηνο  

Δθηεινύκε ηελ επίιπζε από ην αξηζηεξό κελνύ Solution > Solve > Current Ls. 

Όηαλ ηειεηώζνπλ νη ππνινγηζκνί ην πξόγξακκα καο ελεκεξώλεη κε ην κήλπκα 
Solution is done. 
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Bήκα 11: Τπνινγηζκόο ηνπ ζπληειεζηή έληαζεο ηάζεο κέζω ηνπ ΑNSYS 

Μεγέζπλζε ηεο πεξηνρήο ηνπ άθξνπ ηεο ξσγκήο 

 Utility Menu > PlotCtrls > Pan Zoom Rotate... 

Θα εκθαληζηεί ην αθόινπζν παξάζπξν: 

 

 

 

΢ην παξαπάλσ παξάζπξν, παηάκε Win Zoom θαη κεγεζύλνπκε ηελ πεξηνρή ηνπ 

άθξνπ ηεο ξσγκήο, κεηά παηάκε Close θαη θιείλνπκε ην παξάζπξν. 

΢ρεδηάδνπκε ηνπο θόκβνπο κε ηελ ζεηξά εληνιώλ Utility Menu > Plot > Nodes. 

Δλεξγνπνηνύκε ηελ αξίζκεζε ηνλ θόκβσλ κε ηελ ζεηξά εληνιώλ Utility Menu 

> PlotCtrls > Numbering..., κεηά ηζεθάξνπκε ην θνπηάθη γηα ‘Node numbers’ 
θαη παηάκε ΟΚ.  
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Μεηά από απηέο ηηο ελέξγεηεο, ην παξάζπξν γξαθηθώλ καο πξέπεη λα κνηάδεη κε 
ηελ παξαθάησ εηθόλα: 
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Καζνξηζκόο ηεο πνξείαο ηνπ πξνζώπνπ ηεο ξσγκήο: 

Main Menu > General Postproc > Path Operations > Define Path > By 
Nodes 

Δπηιέγνπκε ηνλ θόκβν ζηελ άθξε ηεο ξσγκήο (node #2), κεηά ηνλ θόκβν 

ηέηαξηνπ-ζεκείνπ (node #15), θαη ηειηθά ηνλ ηξίην θόκβν (node #14) πάλσ 
ζηελ επηθάλεηα ηεο ξσγκήο. Σέινο παηάκε ΟΚ. 

΢ην παξαθάησ παξάζπξν πνπ αθνινπζεί, εηζάγνπκε ‘Κ1’ γηα ‘Define Path 
Name’: θαη κεηά παηάκε ΟΚ. 
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Κιείλνπκε ην παξάζπξν ‘PATH Command’: 

 

 

 

 

Καζνξηζκόο ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο. 

Utility Menu > WorkPlane > Local Coordinate Systems > Create Local CS 

> By 3Nodes   

 

Δπηιέγνπκε ηνλ θόκβν 2 ζηελ άθξε ηεο ξσγκήο (node #2), κεηά ηνλ θόκβν 17 

(node #17), θαη ηειηθά ηνλ θόκβν 136 (node #136). Από απηή ηελ ελέξγεηα 
αλνίγεη ην αθόινπζν παξάζπξν: 
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΢ην παξαπάλσ παξάζπξν ζεκεηώλνπκε ‘11’ γηα ‘Ref number of  new coord 

sys’, θαη κεηά παηάκε ΟΚ. 

 

Δλεξγνπνίεζε ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο. 

Utility Menu > WorkPlane > Change Active CS to > Specfied Coord Sys... 

΢ην αθόινπζν παξάζπξν πνπ εκθαλίδεηαη εηζάγνπκε ‘11’ γηα ‘Coordinate 
system number’, θαη κεηά παηάκε ΟΚ. 

 

 

 

Γηα λα ελεξγνπνηήζνπκε ην ζπζηήκαηα ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο 

όπσο ηα απνηειέζκαηα ζπληνληζκνύ ηνπ ζπζηήκαηνο, επηιέγνπκε  

Main Menu > General Postproc > Options for Outp.   
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΢ην παξάζπξν πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε ‘Local system’ γηα 

‘Results coord system’ θαη εηζάγνπκε ‘11’ γηα ‘Local system reference no.’, θαη 
παηάκε ΟΚ ζην παξάζπξν. 

 

 

 

 

Καζνξηζκόο ηνπ παξάγνληα έληαζεο πίεζεο ρξεζηκνπνηώληαο ην KCALC: 

Main Menu > General Postproc > Nodal Calcs > Stress Int Factr 

΢ην παξαθάησ παξάζπξν, επηιέγνπκε ‘Plain strain’ γηα ‘Disp extrapolate based 

on’ θαη ‘Half-symm b.c.’ γηα ‘Model Type’. 
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Παηάκε ΟΚ. Σν παξάζπξν πνπ εκθαλίδεηαη καο δείρλεη όηη νη ζπληειεζηέο 

έληαζεο πίεζεο πνπ δέρεηαη ζηελ άθξε ηεο ε ξσγκή είλαη  

KI = 26.533 ,  KII = 0 ,  KIII = 0 

΢εκεηώλνπκε όηη ηα απνηειέζκαηα  KII = 0 θαη KIII = 0 είλαη πξνθαλή γηα απηό 

ην πξόβιεκα.  

 

 

 

Κιείλνπκε ην παξάζπξν ‘KCALC Command’ 

Μπνξoύκε λα ζειήζνπκε λα αλαθηήζνπκε νιόθιεξν ην δ ηαθξηηνπνηεκέλν 

πξόηππν σο εμήο: 

Δπηιέγνπκε  Utility Menu > PlotCtrls > Pan Zoom Rotate... , κεηά παηάκε Fit 
θαη θιείλνπκε ην παξάζπξν ‘Pan-Zoom-Rotate’. 

Δπηιέγνπκε Utility Menu>Plot>Elements. 
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2Ο ΢ ΣΡΟΠΟ΢ ΔΠΗΛΤ΢Ζ΢ ΢ΥΔΓΗΑΕΟΝΣΑ΢ ΟΛΟΚΛΖΡΖ ΣΖΝ ΠΛΑΚΑ 

 

Βήκα 1: Οξηζκόο ζεκείωλ  

Οξίδνπκε ζεκεία (keypoints) σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor > 

Modeling > Create > Keypoints επηιέγνπκε In Active CS. 

΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ζην πεδίν X,Y,Z Location in 

active CS ηηο ζπληεηαγκέλεο ησλ απαηηνύκελσλ γηα ηνλ νξηζκό ηεο γεσκεηξίαο 
keypoints. Δηζάγνπκε ην πξώην ζεκείν (keypoint) ζην θαηάιιειν παξάζπξν, 

πιεθηξνινγώληαο ηηο x, y ζπληεηαγκέλεο: 0,0 (όπσο παξνπζηάδεηαη θαησηέξσ). 
Δπηιέγνπκε Apply γηα λα δερηεί όηη έρνπκε δαθηπινγξαθήζεη. Δηζάγνπκε θαη 

ηα ππόινηπα ζεκεία (keypoints) ρξεζηκνπνηώληαο ηελ ίδηα κέζνδν.  
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Οη απαηηνύκελεο ζπληεηαγκέλεο γηα ηε δεκηνπξγία ησλ ζεκείσλ (keypoints) ηνπ 
κνληέινπ καο απεηθνλίδνληαη ζην παξαθάησ πίλαθα (Πίλαθαο Π.3): 

 

 

Πίλαθαο Π.3: ΢πληεηαγκέλεο ζεκείσλ 

΢εκεία  (Keypoints) ΢πληεηαγκέλεο  ( Υ, Τ ) 

1 (0,0) 

2 (0.1 0) 

3 (0.2,0) 

4 (0.2,0.1) 

5 (0.2,0.2) 

6 (0.1,0.2) 

7 (0,0.2) 

8 (0,0.1) 

9 (0.08,0.1) 

10 (0.1,0.1) 

11 (0.1,0.1) 

12 (0.12,0.1) 

 

Σα ζεκεία (keypoints) 10 θαη 11 έρνπλ ηηο ίδηεο ζπληεηαγκέλεο, απηό ην θάλακε 
γηα λα δεκηνπξγήζνπκε ηε ζρηζκή νύησο ώζηε κε ηελ θόξηηζε λα γίλεη νξαηό ην 

άλνηγκα ηεο ζρηζκήο. 

 

Βήκα 2: Γεκηνπξγία Concentration Keypoint  

Main Menu > Preprocessor > Meshing > Size Cntrls > Concentrat KPs > 

Create 
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Δπηιέγνπκε ην keypoint #9 θαη κεηά παηάκε ΟΚ ζην παξαθάησ παξάζπξν 

επηινγώλ. 

 

 

 

΢ην παξάζπξν πνπ εκθαλίδεηαη πξέπεη λα βάινπκε ‘9’ γηα Keypoint for 

concentration’. Δηζάγνπκε ‘0.0025’ (= a / 8) γηα ‘Radius of 1
st
 row of elems’, 

επίζεο βάδνπκε ‘8’ γηα ‘No of elems around circumf’ θαη δηαιέγνπκε ‘Skewed 

¼ pt’ γηα ‘midside node position’. Παηάκε ΟΚ.  
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Σελ ίδηα δηαδηθαζία αθνινπζνύκε θαη γηα ην keypoint #12. 

 

Βήκα 3: Γεκηνπξγία γξακκήο  

Δλώλνληαο ηα ζεκεία (keypoints) νξίδνπκε γξακκή (Line) σο εμήο: Από ην 

αξηζηεξό κελνύ Preprocessor > Modeling > Create > Lines > Lines 
επηιέγνπκε Straight Line. Σε γξακκή ηελ νξίδνπκε είηε ζπκπιεξώλνληαο, ζηελ 

θαξηέια πνπ εκθαλίδεηαη, ηα δπν ζεκεία (Keypoints) ζην edit box ηνπ πεδίνπ 
List of items, είηε παηώληαο αξηζηεξό click πάλσ ζηα ζεκεία (keypoints). 

 

 

 

Δλώλνληαο ηα ζεκεία (keypoints) εκθαλίδεηαη ην παξαθάησ ζρήκα: 
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Βήκα 4: Γεκηνπξγία επηθάλεηαο, 

Μπαίλνπκε ζην θπξίσο κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά, ζην 
(preprocessor ) γηα λα δεκηνπξγήζνπκε ηελ πεξηνρή. 

Preprocessor > Modeling > Create > Areas > Rectangle >By Lines 

Δπηιέγνπκε όιεο ηηο γξακκέο θαη παηάκε ΟΚ. 

Όπσο θαίλεηαη θαη ζηελ εηθόλα παξαθάησ, δεκηνπξγνύληαη ηέζζεξηο επηθάλεηεο. 
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Βήκα 5: Οξηζκόο ζηνηρείωλ 

Οξηζκόο ζηνηρείνπ επηθάλεηαο πιάθαο Solid: Από ην αξηζηεξό κελνύ: 

Preprocessor > Element type > Add/edit/delete 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε add θαη ζηε λέα θαξηέια επηιέγνπκε 
solid 8node 82 θαη παηάκε ΟΚ. 
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Πξηλ θιείζνπκε ηελ θαξηέια (element type) παηάκε ηελ επηινγή options θαη καο 

εκθαλίδεηαη κηα θαξηέια όπνπ γηα (element behavior) επηιέγνπκε Plane strain. 

 

 

 

Βήκα 6: Ηδηόηεηεο πιηθνύ 

Ο νξηζκόο ηνπ πιηθνύ ηεο πιάθαο γίλεηαη σο εμήο: Από ην αξηζηεξό κελνύ 

Preprocessor > Material Props > Material models > Structrural > Linear > 
Elastic > Isotropic. ΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ην κέηξν 
ειαζηηθόηεηαο EX: 2Δ5 θαη ην ιόγν Ρoisson PRXY: 0.3. 
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Βήκα 7: Γηαθξηηνπνίεζε πιάθαο  

Γηαθξηηνπνηνύκε ηελ επηθάλεηα σο εμήο: Δπηιέγνπκε από ην αξηζηεξό κελνύ 
Preprocessor > Meshing > Mesh > Areas > Free 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All γηα λα επηιεγνύλ όιεο νη 

επηθάλεηεο πνπ ζέινπκε λα δηαθξηηνπνηεζνύλ.  

 

 

 

Βήκα 8: Οξηζκόο είδνπο αλάιπζεο 

Οξίδνπκε ην είδνο ηεο αλάιπζεο σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor 

> Loads > Analysis Type > New Analysis. ΢ηελ θαξηέια πνπ εκθαλίδεηαη 
επηιέγνπκε Static 

 

Βήκα 9: Οξηζκόο θνξηίνπ 

Γηα λα νξίζνπκε ηε ηηκή θαη ηε δηεύζπλζε ηνπ θνξηίνπ αθνινπζνύκε ηηο εμήο 

εληνιέο: Preprocessor > Loads > Define Loads > Apply >  Structural > 
Pressure > On Lines. ΢ηε ζπλέρεηα επηιέγνπκε ηηο πάλσ θαη θάησ γξακκέο ηεο 

πιάθαο, παηάκε ΟΚ θαη ζηε θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ηε ηηκή 
ηνπ θνξηίνπ (-100).  
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Δπηιέγνληαο ΟΚ απεηθνλίδεηαη ε ηειηθή κνξθή ηνπ πξνβιήκαηνο πξηλ 

πξνβνύκε ζηελ επίιπζε (Solve). 

 

 

 

Bήκα 10: Δπίιπζε ηνπ ζπζηήκαηνο  

Δθηεινύκε ηελ επίιπζε από ην αξηζηεξό κελνύ Solution > Solve > Current Ls. 

Όηαλ ηειεηώζνπλ νη ππνινγηζκνί ην πξόγξακκα καο ελεκεξώλεη κε ην κήλπκα 
Solution is done. 
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Bήκα 11: Τπνινγηζκόο ηνπ ζπληειεζηή έληαζεο ηάζεο κέζω ηνπ ΑNSYS 

Μεγέζπλζε ηεο πεξηνρήο ηνπ άθξνπ ηεο ξσγκήο 

 Utility Menu > PlotCtrls > Pan Zoom Rotate... 

Θα εκθαληζηεί ην αθόινπζν παξάζπξν: 

 

 

 

΢ην παξαπάλσ παξάζπξν, παηάκε Win Zoom θαη κεγεζύλνπκε ηελ πεξηνρή ηνπ 

άθξνπ ηεο ξσγκήο, κεηά παηάκε Close θαη θιείλνπκε ην παξάζπξν. 

΢ρεδηάδνπκε ηνπο θόκβνπο κε ηελ ζεηξά εληνιώλ Utility Menu > Plot > Nodes. 

Δλεξγνπνηνύκε ηελ αξίζκεζε ηνλ θόκβσλ κε ηε ζεηξά εληνιώλ Utility Menu > 

PlotCtrls > Numbering..., κεηά ηζεθάξνπκε ην θνπηάθη γηα ‘Node numbers’ 
θαη παηάκε ΟΚ.  
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Μεηά από απηέο ηηο ελέξγεηεο, ην παξάζπξν γξαθηθώλ καο πξέπεη λα κνηάδεη κε 
ηελ παξαθάησ εηθόλα: 
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Καζνξηζκόο ηεο πνξείαο ηνπ πξνζώπνπ ηεο ξσγκήο: 

Main Menu > General Postproc > Path Operations > Define Path > By 
Nodes 

Δπηιέγνπκε ηνλ θόκβν ζηελ άθξε ηεο ξσγκήο (node #2), κεηά ηνλ θόκβν 

ηέηαξηνπ-ζεκείνπ (node #274), θαη ηειηθά ηνλ ηξίην θόκβν (node #273 πάλσ 
ζηελ επηθάλεηα ηεο ξσγκήο). Σέινο παηάκε ΟΚ. 

΢ην παξαθάησ παξάζπξν πνπ αθνινπζεί, εηζάγνπκε ‘Κ1’ γηα ‘Define Path 
Name :’, θαη κεηά παηάκε ΟΚ. 
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Κιείλνπκε ην παξάζπξν ‘PATH Command’. 

 

 

 

Καζνξηζκόο ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο. 

Utility Menu > WorkPlane > Local Coordinate Systems > Create Local CS 

> By 3Nodes   

 

Δπηιέγνπκε ηνλ θόκβν ζηελ άθξε ηεο ξσγκήο (node #2), κεηά ηνλ θόκβν (node 

#35), θαη ηειηθά ηνλ θόκβν (node #383). Από απηή ηελ ελέξγεηα αλνίγεη ην 
αθόινπζν παξάζπξν: 
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΢ην παξαπάλσ παξάζπξν ζεκεηώλνπκε ‘11’ γηα ‘Ref number of  new coord sys’ 

θαη κεηά παηάκε ΟΚ. 

 

Δλεξγνπνίεζε ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο. 

Utility Menu > WorkPlane > Change Active CS to > Specfied Coord Sys ... 

΢ην αθόινπζν παξάζπξν πνπ εκθαλίδεηαη εηζάγνπκε ‘11’ γηα ‘Coordinate 
system number’ θαη κεηά παηάκε ΟΚ. 

 

 

 

 

Γηα λα ελεξγνπνηήζνπκε ην ζπζηήκαηα ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο, 
όπσο ηα απνηειέζκαηα ζπληνληζκνύ ηνπ ζπζηήκαηνο, επηιέγνπκε:  

Main Menu > General Postproc > Options for Outp.   
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΢ην παξάζπξν πνπ εκθαλίδεηαη παξαθάησ επηιέγνπκε ‘Local system’ γηα 

‘Results coord system’ θαη εηζάγνπκε ‘11’ γηα ‘Local system reference no.’, θαη 
κεηά παηάκε ΟΚ. 

 

 

 

 

Καζνξηζκόο ηνπ παξάγνληα έληαζεο πίεζεο ρξεζηκνπνηώληαο ην KCALC: 

Main Menu > General Postproc > Nodal Calcs > Stress Int Factr 

΢ην παξαθάησ παξάζπξν, επηιέγνπκε ‘Plain strain’ γηα ‘Disp extrapolate based 

on’ θαη ‘Half-symm b.c.’ γηα ‘Model Type’. 
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Παηάκε ΟΚ. Σν παξάζπξν πνπ εκθαλίδεηαη καο δείρλεη όηη νη ζπληειεζηέο 

έληαζεο πίεζεο πνπ δέρεηαη ζηελ άθξε ηεο ε ξσγκή είλαη  

KI = 26.197 ,  KII = 0 ,  KIII = 0 

΢εκεηώλνπκε όηη ηα απνηειέζκαηα  KII = 0 θαη KIII = 0 είλαη πξνθαλή γηα απηό 

ην πξόβιεκα.  

 

 

 

Π.4  ΠΡΟΒΛΖΜΑ 2.4 ΔΤΡΔ΢Ζ ΣΟΤ ΢ΤΝΣΔΛΔ΢ΣΖ ΔΝΣΑ΢Ζ΢ ΣΑ΢Ζ΢ ΠΛΑΚΑ΢ 

ΜΔ ΡΧΓΜΖ ΢ΣΖΝ ΑΚΡΖ  

 

Βήκα 1: Οξηζκόο ζεκείωλ  

Οξίδνπκε ζεκεία (keypoints) σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor > 

Modeling > Create > Keypoints επηιέγνπκε In Active CS. 
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΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ζην πεδίν X,Y,Z Location in 

active CS ηηο ζπληεηαγκέλεο ησλ απαηηνύκελσλ γηα ηνλ νξηζκό ηεο γεσκεηξίαο 
keypoints. Δηζάγνπκε ην πξώην ζεκείν (keypoint) ζην θαηάιιειν παξάζπξν, 
πιεθηξνινγώληαο ηηο x, y ζπληεηαγκέλεο: 0,0 (όπσο παξνπζηάδεηαη θαησηέξσ). 

Δπηιέγνπκε Apply γηα λα δερηεί όηη έρνπκε δαθηπινγξαθήζεη. Δηζάγνπκε θαη 
ηα ππόινηπα ζεκεία ρξεζηκνπνηώληαο ηελ ίδηα κέζνδν.  

 

 

 

Οη απαηηνύκελεο ζπληεηαγκέλεο γηα ηε δεκηνπξγία ησλ ζεκείσλ (keypoints) ηνπ 

κνληέινπ καο θαηαγξάθνληαη ζην παξαθάησ πίλαθα (Πίλαθαο Π.4): 

 

Πίλαθαο Π.4: ΢πληεηαγκέλεο ζεκείσλ 

΢εκεία  (keypoints) ΢πληεηαγκέλεο  ( Υ, Τ ) 

1 (0,0) 

2 (0.2,0) 

3 (0.2,0.1) 

4 (0.2,0.2) 

5 (0,0.2) 

6 (0,0.1) 

7 (0,0.1) 

8 (0.02,0.1) 

 

 



 

 

133 

Αλ παξαηεξήζνπκε ηα ζεκεία 6 θαη 7 έρνπλ ηηο ίδηεο ζπληεηαγκέλεο, απηό έγηλε 

γηα λα δεκηνπξγήζνπκε ηελ ζρηζκή νύησο ώζηε κε ηελ θόξηηζε λα γίλεη νξαηό 
ην άλνηγκά ηεο. 

 

Βήκα 2: Γεκηνπξγία Concentration Keypoint  

Main Menu > Preprocessor > Meshing > Size Cntrls > Concentrat KPs > 

Create 

 

Δπηιέγνπκε ην keypoint #8 θαη κεηά παηάκε ΟΚ ζην παξαθάησ παξάζπξν 

εηπινγώλ. 

 

 

 

΢ην παξαθάησ παξάζπξν πξέπεη λα βάινπκε ‘8’ γηα ‘Keypoint for 
concentration’. Δηζάγνπκε ‘0.0025’ (=a/8) γηα ‘Radius of 1

st
 row of elems’, 

επίζεο βάδνπκε ‘8’ γηα ‘No of elems around circumf’ θαη δηαιέγνπκε ‘Skewed 
¼ pt’ γηα ‘midside node position’. Παηάκε ΟΚ.  
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Βήκα 3: Γεκηνπξγία γξακκήο  

Δλώλνληαο ηα ζεκεία (keypoints) νξίδνπκε γξακκή (line) σο εμήο: Από ην 
αξηζηεξό κελνύ Preprocessor > Modeling > Create > Lines > Lines 

επηιέγνπκε Straight Line. Σε γξακκή ηελ νξίδνπκε είηε ζπκπιεξώλνληαο, ζηελ 
θαξηέια πνπ εκθαλίδεηαη ηα δπν ζεκεία (Keypoints) ζην edit box ηνπ πεδίνπ 

List of items, είηε παηώληαο αξηζηεξό click πάλσ ζηα ζεκεία (keypoints). 

 

 

 

 

Δλώλνληαο ηα ζεκεία εκθαλίδεηαη ην παξαθάησ ζρήκα: 
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Βήκα 4: Γεκηνπξγία επηθάλεηαο 

Μπαίλνπκε ζην θπξίσο κελνύ (main menu), πνπ βξίζθεηαη αξηζηεξά, ζην 
(preprocessor) γηα λα δεκηνπξγήζνπκε ηελ πεξηνρή. 

Preprocessor > Modeling > Create > Areas > Rectangle > By Lines 

Καη επηιέγνπκε όιεο ηηο γξακκέο θαη παηάκε ΟΚ. 

Όπσο θαίλεηαη θαη ζηελ εηθόλα παξαθάησ δεκηνπξγνύληαη δύν επηθάλεηεο. 
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Βήκα 5: Οξηζκόο ζηνηρείωλ 

Οξηζκόο ζηνηρείνπ επηθάλεηαο πιάθαο Solid: Από ην αξηζηεξό κελνύ: 

Preprocessor > Element type > Add/edit/delete 

΢ηελ θαξηέια πνπ εκθαλίδεηαη παηάκε add θαη ζηε λέα θαξηέια επηιέγνπκε 

solid 8node 82 θαη παηάκε ΟΚ. 
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Πξηλ θιείζνπκε ηελ θαξηέια (element type) παηάκε ηελ επηινγή options θαη καο 

εκθαλίδεηαη κηα θαξηέια όπνπ γηα (element behavior) επηιέγνπκε Plane strain 

 

 

 

Βήκα 6: Ηδηόηεηεο πιηθνύ 

Ο νξηζκόο ηνπ πιηθνύ ηεο πιάθαο γίλεηαη σο εμήο: Από ην αξηζηεξό κελνύ 

Preprocessor > Material Props > Material models > Structural > Linear > 
Elastic > Isotropic. ΢ηελ θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ην κέηξν 
ειαζηηθόηεηαο EX: 2Δ5 θαη ην ιόγν Poisson PRXY: 0.3. 
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Βήκα 7: Γηαθξηηνπνίεζε πιάθαο  

Γηαθξηηνπνηνύκε ηελ επηθάλεηα σο εμήο: Δπηιέγνπκε από ην αξηζηεξό κελνύ 
Preprocessor > Meshing > Mesh > Areas > Free 

΢ηε θαξηέια πνπ εκθαλίδεηαη παηάκε Pick All γηα λα επηιεγνύλ όιεο νη 

επηθάλεηεο πνπ ζέινπκε λα δηαθξηηνπνηεζνύλ.  

 

 

 

Βήκα 8: Οξηζκόο είδνπο αλάιπζεο 

Οξίδνπκε ην είδνο ηεο αλάιπζεο σο εμήο: Από ην αξηζηεξό κελνύ Preprocessor 

> Loads > Analysis Type > New Analysis . ΢ηε θαξηέια πνπ εκθαλίδεηαη 
επηιέγνπκε Static. 

 

Βήκα 9: Οξηζκόο θνξηίνπ 

Γηα λα νξίζνπκε ηε ηηκή θαη ηε δηεύζπλζε ηνπ θνξηίνπ αθνινπζνύκε ηηο εμήο 

εληνιέο: Preprocessor > Loads > Define Loads > Apply >  Structural > 
Pressure > On Lines   ΢ηε ζπλέρεηα επηιέγνπκε ηηο πάλσ θαη θάησ γξακκέο ηεο 

πιάθαο, παηάκε ΟΚ θαη ζηε θαξηέια πνπ εκθαλίδεηαη ζπκπιεξώλνπκε ηε ηηκή 
ηνπ θνξηίνπ (-100).  
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Δπηιέγνληαο ΟΚ απεηθνλίδεηαη ε ηειηθή κνξθή ηνπ πξνβιήκαηνο πξηλ 
πξνβνύκε ζηελ επίιπζε (Solve). 
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Bήκα 10: Δπίιπζε ηνπ ζπζηήκαηνο  

Δθηεινύκε ηελ επίιπζε από ην αξηζηεξό κελνύ Solution > Solve > Current Ls. 
Όηαλ ηειεηώζνπλ νη ππνινγηζκνί, ην πξόγξακκα καο ελεκεξώλεη κε ην κήλπκα 

Solution is done 

 

 

 

 

Bήκα 11: Τπνινγηζκόο ηνπ ζπληειεζηή έληαζεο ηάζεο κέζω ηνπ ANSYS 

 

Μεγέζπλζε ηεο πεξηνρήο ηνπ άθξνπ ηεο ξσγκήο 

 Utility Menu > PlotCtrls > Pan Zoom Rotate... 

Θα εκθαληζηεί ην αθόινπζν παξάζπξν: 
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΢ην παξαπάλσ παξάζπξν, παηάκε Win Zoom θαη κεγεζύλνπκε ηελ πεξηνρή ηνπ 

άθξνπ ηεο ξσγκήο, κεηά παηάκε Close θαη θιείλνπκε ην παξάζπξν. 

΢ρεδηάδνπκε ηνπο θόκβνπο κε ηελ ζεηξά εληνιώλ Utility Menu > Plot > Nodes. 

Δλεξγνπνηνύκε ηελ αξίζκεζε ηνλ θόκβσλ κε ηελ ζεηξά εληνιώλ Utility Menu 

> PlotCtrls > Numbering..., κεηά ηζεθάξνπκε ην θνπηάθη γηα ‘Node numbers’ 
θαη ηειηθά παηάκε ΟΚ.  
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Μεηά από απηέο ηηο ελέξγεηεο ην παξάζπξν γξαθηθώλ καο πξέπεη λα κνηάδεη κε 
ηελ παξαθάησ εηθόλα: 
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Καζνξηζκόο ηεο πνξείαο ηνπ πξνζώπνπ ηεο ξσγκήο: 

Main Menu > General Postproc > Path Operations > Define Path > By 
Nodes 

 

Δπηιέγνπκε ηνλ θόκβν ζηελ άθξε ηεο ξσγκήο (node #22), κεηά ηνλ θόκβν 
ηέηαξηνπ-ζεκείνπ (node #273), θαη ηειηθά ηνλ ηξίην θόκβν (node #272) πάλσ 

ζηελ επηθάλεηα ηεο ξσγκήο. Σέινο παηάκε ΟΚ. 

΢ην παξαθάησ παξάζπξν, εηζάγνπκε ‘Κ1’ γηα ‘Define Path Name:’ θαη παηάκε 
ΟΚ. 

 

 

 

Κιείλνπκε ην παξάζπξν ‘PATH Command’. 
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Καζνξηζκόο ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο: 

Utility Menu > WorkPlane > Local Coordinate Systems > Create Local CS 
> By 3Nodes   

 

Δπηιέγνπκε ηνλ θόκβν ζηελ άθξε ηεο ξσγκήο (node #22), κεηά ηνλ θόκβν (node 
#37), θαη ηειηθά ηνλ θόκβν (node #144). Από απηή ηελ ελέξγεηα αλνίγεη ην 

αθόινπζν παξάζπξν: 

 

 

 

΢ην παξαπάλσ παξάζπξν ζεκεηώλνπκε ‘11’ γηα ‘Ref number of  new coord 

sys’, θαη παηάκε ΟΚ. 

 

Δλεξγνπνίεζε ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο. 

Utility Menu > WorkPlane > Change Active CS to > Specfied Coord Sys ... 

 

΢ην αθόινπζν παξάζπξν πνπ εκθαλίδεηαη εηζάγνπκε ‘11’ γηα ‘Coordinate 
system number’ θαη παηάκε ΟΚ. 
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Γηα λα ελεξγνπνηήζνπκε ην ζύζηεκα ζπληεηαγκέλσλ ζηελ άθξε ηεο ξσγκήο 

όπσο ηα απνηειέζκαηα ζπληνληζκνύ ηνπ ζπζηήκαηνο, επηιέγνπκε:  

Main Menu > General Postproc > Options for Outp.   

΢ην παξάζπξν πνπ εκθαλίδεηαη επηιέγνπκε ‘Local system’ γηα ‘Results coord 

system’ θαη εηζάγνπκε ‘11’ γηα ‘Local system reference no.’, θαη κεηά παηάκε 
ΟΚ ζην παξάζπξν. 

 

 

 

Καζνξηζκόο ηνπ παξάγνληα έληαζεο πίεζεο ρξεζηκνπνηώληαο ην KCALC: 

Main Menu > General Postproc > Nodal Calcs > Stress Int Factr 
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΢ην παξαθάησ παξάζπξν, επηιέγνπκε ‘Plain strain’ γηα ‘Disp extrapolate based 

on’ θαη ‘Half-symm b.c.’ γηα ‘Model Type’. 

 

 

 

Παηάκε ΟΚ. Σν παξάζπξν πνπ εκθαλίδεηαη καο δείρλεη όηη νη ζπληειεζηέο 

έληαζεο πίεζεο πνπ δέρεηαη ζηελ άθξε ηεο ε ξσγκή είλαη  

KI = 30.752,  KII = 0 ,  KIII = 0 

 

΢εκεηώλνπκε όηη ηα απνηειέζκαηα  KII = 0 θαη KIII = 0 είλαη πξνθαλή γηα απηό 

ην πξόβιεκα.  
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Κιείλνπκε ην παξάζπξν ‘KCALC Command’. 

Μπνξoύκε λα αλαθηήζνπκε νιόθιεξν ην δηαθξηηνπνηεκέλν πξόηππν σο εμήο: 

Δπηιέγνπκε  Utility Menu > PlotCtrls > Pan Zoom Rotate ... , κεηά παηάκε 
Fit θαη θιείλνπκε ην παξάζπξν ‘Pan-Zoom-Rotate’. Δπηιέγνπκε Utility Menu > 

Plot > Elements. 

 

 

 


